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Preface

Thank you for purchasing this Topcon product. The materials available in this Manual (the “Manual”) have been
prepared by Topcon Positioning Systems, Inc. ("TPS") for owners of Topcon products, and are designed to assist
owners with the use of the receiver and its use is subject to these terms and conditions (the “Terms and
Conditions”).

@ Please read the terms and conditions carefully.

Terms and Conditions

Preface

Use
This product is designed to be used by a professional. The user should have a good knowledge of the safe use of

the product and implement the types of safety procedures recommended by the local government protection
agency for both private use and commercial job sites.
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Copyrights

All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights
are reserved. Do not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute,
or allow any third party access to, any graphics, content, information or data in this Manual without TPS’ express
written consent and may only use such information for the care and operation of the receiver. The information
and data in this Manual are a valuable asset of TPS and are developed by the expenditure of considerable work,
time and money, and are the result of original selection, coordination and arrangement by TPS.

2dekjold

Trademarks

TRU™, Topcon®, and Topcon Positioning Systems™ are trademarks or registered trademarks of TPS.
Windows® is a registered trademark of Microsoft Corporation. The Bluetooth® word mark and logos are owned
by Bluetooth SIG, Inc. and any use of such marks by Topcon Positioning Systems, Inc. is used under license.
Other product and company names mentioned herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT,
THIS MANUAL AND THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS
DISCLAIMS ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR
PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM
THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED
DAMAGES INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF
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PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE PRODUCT'S USE. IN ADDITION TPS IS NOT RESPONSIBLE
OR LIABLE FOR DAMAGES OR COSTS INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS
OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, TPS SHALL
HAVE NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN EXCESS
OF THE PURCHASE PRICE FOR THE RECEIVER.

2dekjold

License Agreement

Use of any computer programs or software supplied by TPS or downloaded from a TPS website (the “Software”)
in connection with the receiver constitutes acceptance of these Terms and Conditions in this Manual and an
agreement to abide by these Terms and Conditions. The user is granted a personal, non-exclusive, non-
transferable license to use such Software under the terms stated herein and in any case only with a single
receiver or single computer. You may not assign or transfer the Software or this license without the express
written consent of TPS. This license is effective until terminated. You may terminate the license at any time by
destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of the Terms
or Conditions. You agree to destroy the Software and manual upon termination of the use of the receiver. All
ownership, copyright and other intellectual property rights in and to the Software belong to TPS. If these license
terms are not acceptable, return any unused software and manual.

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS' Confidential Information with a degree of care no less
stringent that the degree of care you would use in safeguarding your own most valuable trade secrets. Nothing
in this paragraph shall restrict you from disclosing Confidential Information to your employees as may be
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necessary or appropriate to operate or care for the receiver. Such employees must also keep the Confidentiality
Information confidential. In the event you become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a protective order or other appropriate
remedy.

2dekjold

Website; Other Statements

No statement contained at the TPS website (or any other website) or in any other advertisements or TPS
literature or made by an employee or independent contractor of TPS modifies these Terms and Conditions
(including the Software license, warranty and limitation of liability).

Safety
Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The

receiver should only be repaired by authorized TPS warranty service centers. Users should review and heed the
safety warnings in an Appendix.

Miscellaneous

The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in accordance with, the laws of the State of
California, without reference to conflict of laws.
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Manual Conventions

This manual uses the following conventions:

2dekjold

Convention Description Example

Bold Menu, or drop-down menu selection File » Exit (Click the File menu and click Exit)
Name of a dialog box or screen From the Connection screen...
Button or key commands Click Finish.

Mono User supplied text or variable Type guest, and click Enter.

Italic Reference to another manual or help document Refer to the Topcon Reference Manual.

Further information to note about system configuration, maintenance, or setup.

performance, data integrity, measurements, or personal safety.

Notification that an action has the potential to result in system damage, loss of data, loss of
warranty, or personal injury.

® Supplementary information that can have an adverse affect on system operation, system
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Introduction

Topcon Receiver Utility™ (TRU) is a software product designed for users who need to configure the receiver hardware or
peripheral devices (internal, and external modems, Bluetooth® boards, etc.). It is available for installation on any personal
computer and hand-held controllers (Mobile devices). This manual describes version 2.8 of TRU with the Base license type of
register intended for general users.

Installing TRU

You can install TRU on any personal computer with Microsoft Windows XP Service Pack 2 or later, or into controllers with
Windows Mobile 5.0 or later. Two types of installers are available: one for personal computers and one for Mobile devices.

To install TRU onto the controller, run the Mobile Installer on the PC. The Installer automatically detects the mobile platform
connected to the PC (CPU, OS, specific hardware) and installs an appropriate edition of TRU onto the controller. After
installation, shortcuts on the desktop and in the Program menu are created.

To start TRU, double-click the shortcut E or launch the software from the Start menu.

Introduction P/N: 7010-0908 1



Main Window

The Main Window consists of a Menu Bar, Tools Area, and Status Bar (Figure 1).

Menu Bar — ||| Device View Help

M o

Terminal Information

5
-+
=
o
ol
c
a
©)
3

Tools —

Receiver Settings Status File Explorer Modem Driver

Status — ) Receiver Managing Mode &

Figure 1: Main Window

The Menu Bar has the following components:
* Device — contains options that allow connecting to a device, changing general-purpose parameters, and
selecting the application mode.
* View — shows or hides the status bar.
* Help - allows you to register the version of TRU, and view Help and TRU version.
The Tools Area contains icons for the tools included in the current software mode. Each tool is designated by an
icon. An icon can also open the next menu level.
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~ The tools area is inactive until a connection to a device is established. (The connection icon in the
= status bar is green)

The Status Bar shows the current mode and the connection status icon. (The green icon indicates that the device
is connected with TRU; the gray indicates that there is no connection.) You can hide the status bar by unchecking the
Status Bar option under the View menu in the menu bar.
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Device

The device submenu items are Connect (“Connection” on page 8), Disconnect, Setup, and Application Modes
(Figure 2).

IDevice View Help

Connect
Disconnect i

Setup Options Tools

Application Mode

& E-

Receiver Settings Status File Explorer Modem Driver

) Receiver Managing Mode * :

Figure 2: Device Submenu
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Device

Application Modes

Topcon Receiver Utility has four application modes:

* Simple Terminal — In this mode, TRU is used only as a terminal. This mode is also used to update the firmware
of inoperative receivers.

* Receiver Managing (default) — used for configuring GNSS receivers and OEM boards.

* Modem Managing — used for configuring internal and external modems.

* Firmware Loader — used for updating firmware in GNSS receivers and modem/Bluetooth/power boards.
You can choose the application mode from the Device menu.

Setup

To change general-purpose parameters, select Device » Setup from the Main Window. The Setup dialog box
contains three tabs, General, Status, and Modems.

General

The General tab configures a way to display the receiver position in the Status dialogs. You can select either Geodetic
(Latitude, Longitude, Altitude) or Cartesian (X,Y,Z) coordinate system.

Status
In the Status tab, you can view and modify colors used for representing a solution type in the Status dialogs.

P/N: 7010-0908
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Modems
The Modems tab shows that automatic mode is set for detection of the modem.

<//\/§S Manual Selection is not allowed for the Base license type.

Help
The Help submenu items are Register, Help, and About...
(@ U (=] 5 i
Device View
Register pr— ’
- Help = ‘il
Terminal About... ptions Tools
— b* = ;-_II —
=.-f K I"-‘I S =
Receiver Settings Status File Explorer Modem Driver
4 Receiver Managing Mode a i

Figure 3: Help Submenu
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Register

1. To view or update your license for using TRU, click Help » Register. The Register dialog box displays.
* License Type — The Base version is intended for general users.

<//\>€S This manual describes the Base version of TRU.

* Update the license — If you know the Serial Number for your Computer UID, you are able to change the
Base license type for other license.

Only the license base version is available for users. Topcon will notify distribution if there is any
need for you to obtain an advanced TRU license.

2. Click Update the license, to view the UID number for your computer.
3. Enter an appropriate serial number to view the license type to which this number corresponds.

4. Click OK to save the update.

Help

To display Help:
* On a hand-held controller with Windows Mobile, click the question mark in the upper-right corner of each
screen.
* On a hand-held controller with Windows CE, click the question mark in the Menu Bar.
* On a personal computer, click the F1 key or click Help » Help in the Menu Bar.

Help P/N: 7010-0908
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About

Click Help » About from the Menu Bar in the Main Window to display information about the software, such as
the version number, date created, application edition, and the name of publishing company.

Exiting TRU

1. To exit TRU:
* From the Menu Bar in the Main Window, select Device » Exit, or
« from the Menu Bar in the Main Window, click the close button jmess in the upper right corner.

2. After one of the methods above is used to begin closing the program, TRU verifies exiting. Click Yes to exit TRU,
or click No to continue using TRU.

2 /gs The close button jsedem only closes TRU from the Main Window. From within any submenu, this
button returns to the upper level window.

Exiting TRU P/N: 7010-0908
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Connection

Connecting to the Device

You can establish a connection to your device in any of the four application modes:
* Simple Terminal mode allows advance users to connect with receivers, including devices not supported by TRU,
through manual commands. (See “Simple Terminal” on page 25 for more information on Simple Terminal mode.)

* Receiver Managing mode allows you to configure Topcon GNSS receivers. When in this mode, TRU automatically tries
to detect a receiver at the time of connection. If there is no receiver, or if it does not respond, a connection cannot be
established. (See “Receiver Managing” on page 29 for more information on Receiver Managing mode.)

* Modem Managing mode allows you to configure Topcon and third-party modems.(See *“Modem Managing” on page 89
for more information on Modem Managing mode.)

e Firmware Loader mode allows you to load firmware onto various devices within a Topcon GNSS receiver. (See
“Firmware Loader” on page 115 for more information on Firmware Loader mode.)

In any of these application modes, you can connect to a receiver via Serial Port, Bluetooth, Network, or USB (PC version
of TRU only).

The following sections describe how to connect to your device.

Bluetooth transport may not be available in the following situations: a device-specific Bluetooth stack is
//,QS not supported by TRU, or the Bluetooth power is turned off. If the Bluetooth power is off, turn on the
- Bluetooth power before using a Bluetooth manager. Server operating systems also do not support
Bluetooth.

Connection P/N: 7010-0908 8



If your version of TRU, for the specified platform, does not support installed Bluetooth stack, use
virtual serial ports provided by a Bluetooth manager for your Bluetooth radio.

To use a USB connection, install a Topcon USB driver designed for your specific operating system
version and system type (32- or 64-bit). Visit www.topcontotalcare.com to get information on latest
USB driver available for Topcon GNSS receivers.

uoljpauuo)
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Serial Port Connection

Q)
1. To establish a serial port connection to the device, select Device » Connect from the Menu Bar on the Main @]
Window. The Connection Parameters dialog box displays. g
K - 2
£ Connection Par... I. == ﬁJ Er
Connect Using g
Serial Port hd
Serial Port
USE
Metwaork

W COMT [Communications Port] u

Figure 4: Connection Parameters Dialog Box

b

2. Select Serial Port from the Connect Using drop-down menu.
3. Select the Port Name by clicking the List button [...] .

Connecting to the Device P/N: 7010-0908 10



4. On the Select Port dialog box (Figure 8), highlight the port, click and hold, or right-click, and click Select the

port. A
. \ o
45 Select Port l =R é] 3
-
Friendly Name Physic... H (0]
o 0
§C0mmun Select the port :“.
Device info O
o
Refresh
(

Figure 5: Select Port Dialog Box and Pop-up Menu

You can also select Device Info from the Port Name pop-up menu (Figure 8) to view information about the selected
port.

Connecting to the Device P/N: 7010-0908 11



The Device Info dialog box displays both the physical and friendly Device Names of the serial port. Click the close
button feeae to exit.

1 " Device Info l & &_J

Device Names
5 Friendly: Communications Port
Physical:  \\.\COM1

Class of Device

uoljpauuo)

Major: Miscellaneous

Minor:

Services:

Figure 6: Device Info Dialog Box

5. Click Ok on the Select Port dialog box (Figure 5).
6. If available, check the Internal Modem box and select the GNSS receiver port to which an internal modem is
connected from the Receiver Port drop-down menu.

@@ Receiver Port is only available in Modem Managing mode.
~

Connecting to the Device P/N: 7010-0908 12



7. Click Connect to establish a connection to your device (Figure 4).

TRU always remembers the last successful port settings. When you try to establish a new connection,
//ZS TRU first tries to use the last selected settings. The connection is established right away if you are

~ . .
connecting to the same device.

uoljpauuo)

— When TRU is in Simple Terminal mode, it just opens the port. TRU does not try to detect the hardware
connected to the port, nor change the port settings.
— When TRU is in Receiver Managing mode, it attempts to detect the device connected to the port.

— When detecting a receiver, the Detecting Receiver dialog box displays. An ActiveSync animated icon
and the Cancel button displays. Additional parameters display when using serial transport, i.e., baud
rate and flow control.

— When TRU is in Modem Managing mode and auto detection is setup, it tries to detect a modem at the time
of connection. If there is no modem, or if it does not respond, a connection cannot be established.

— When detecting a modem, the Detecting Modem dialog displays identical to the Detecting Receiver
dialog box.

Click Cancel to terminate the process.

Connecting to the Device P/N: 7010-0908 13



Bluetooth Connection

1. To establish a Bluetooth connection to the device, click Device » Connect from the Menu Bar on the Main
Window. The Connection Parameters dialog box displays.

55 Connection Par... l | [E] | S

Connect Using

uoljpauuo)

[serial Port -]

Serial Port
Network

L

Figure 7: Connection Parameters Dialog Box

2. Select Bluetooth from the Connect Using drop-down menu.
3. Select the Device Name by dlicking the List button [ ... .

Connecting to the Device P/N: 7010-0908 14



4. On the Select Device dialog box (Figure 8), highlight the Bluetooth device, click and hold it, or right-click and

select Select the port or get the device information on that port from the pop-up menu. a
. . o
G5 Select Port l‘:' Cl éj 3
-
Friendly Name Physic... H (0]
- Select the port ol
ommun e epo —
jc Device info O
o
Refresh
'

Figure 8: Select Port Dialog Box and Pop-up Menu

You can also, select Device Info from the Port Name pop-up menu (Figure 8) to view information about the selected
port.

Connecting to the Device P/N: 7010-0908 15



The Device Info dialog box displays both the physical and friendly Device Names of the serial port. Click the close
button feeae to exit.

1 " Device Info l & &_J

Device Names
5 Friendly: Communications Port
Physical:  \\.\COM1

Class of Device

uoljpauuo)

Major: Miscellaneous

Minor:

Services:

Figure 9: Device Info Dialog Box

5. If available, check the Internal Modem box and select the GNSS receiver port to which an internal modem is
connected from the Receiver Port drop-down menu.

///QS Receiver Port is only available in Modem Managing mode.

6. Click Ok on the Select Port dialog box.

Connecting to the Device P/N: 7010-0908 16



7. Click Connect to establish a connection to your device. .

TRU always remembers the last successful port settings. When you try to establish a new connection,
//ZS TRU first tries to use the last selected settings. The connection is established right away if you are

~ . .
connecting to the same device.

uoljpauuo)

— When TRU is in Simple Terminal mode, it just opens the port. TRU does not try to detect the hardware
connected to the port, nor change the port settings.
— When TRU is in Receiver Managing mode, it attempts to detect the device connected to the port.

— When detecting a receiver, the Detecting Receiver dialog box displays. An ActiveSync animated icon
and the Cancel button displays. Additional parameters display when using serial transport, i.e., baud
rate and flow control.

— When TRU is in Modem Managing mode and auto detection is setup, it tries to detect a modem at the time
of connection. If there is no modem, or if it does not respond, a connection cannot be established.

— When detecting a modem, the Detecting Modem dialog displays identical to the Detecting Receiver
dialog box.

Click Cancel to terminate the process.

Connecting to the Device P/N: 7010-0908 17



USB Connection

Q)
1. To establish a USB connection to the device, select Device » Connect from the Menu Bar on the Main o]
Window. The Connection Parameters dialog box displays. g
F - m
5 Connection Par... |. =R & 8-.
Connect Using g
[serial Port -]

Serial Port
Metwork
. ommunications For

Figure 10: Connection Parameters Dialog Box

b

2. Select USB from the Connect Using drop-down menu.

Connecting to the Device P/N: 7010-0908 18



3. Select the Device Name by clicking the List button E], and choose the receiver from the list.

@@ Device Name is only available in Receiver Managing and Modem Managing modes.

uoljpauuo)

4. If available, check the Internal Modem box and select the GNSS receiver port to which an internal modem is
connected from the Receiver Port drop-down menu.

@QS Receiver Port is only available in Modem Managing mode.

5. Click Ok.
6. Click Connect to establish a connection to your device.

TRU always remembers the last successful port settings. When you try to establish a new connection,
///@ TRU first tries to use the last selected settings. The connection is established right away if you are

~ . .
connecting to the same device.

— When TRU is in Simple Terminal mode, it just opens the port. TRU does not try to detect the hardware
connected to the port, nor change the port settings.
— When TRU is in Receiver Managing mode, it attempts to detect the device connected to the port.
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— When detecting a receiver, the Detecting Receiver dialog box displays. An ActiveSync animated icon
and the Cancel button displays. Additional parameters display when using serial transport, i.e., baud
rate and flow control.

— When TRU is in Modem Managing mode and auto detection is setup, it tries to detect a modem at the time
of connection. If there is no modem, or if it does not respond, a connection cannot be established.

— When detecting a modem, the Detecting Modem dialog displays identical to the Detecting Receiver
dialog box.

Click Cancel to terminate the process.

uoljpauuo)
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Network Connection

Q)
1. To establish a serial port connection to the device, select Device » Connect from the Menu Bar on the Main @]
Window. The Connection Parameters dialog box displays. g
F - m
5 Connection Par... I. | ol e S 8..
Connect Using g
[serial Port -]
Serial Port
USB
Metwork

e ommunications For ’

Figure 11: Connection Parameters Dialog Box

b

2. Select the New from the Connect Using drop-down menu.

3. Click the List button [ ... | under Device Name.
4. Specify the network settings for your receiver from the Network Connection dialog box (Figure 12):
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e [P address or host name

e TCP port number a)
* Password g
=
] ()]
B8 Metwork Conne... E@ﬁ QI-
IP Address or Host Name 6 '
-]

TCP Port

Password

I [ OK ] [ Cancel ]
Figure 12: Network Connection Dialog Box
5. Click Ok.

6. Click Connect to establish a connection to your device.
TRU always remembers the last successful port settings. When you try to establish a new connection,

///ZS TRU first tries to use the last selected settings. The connection is established right away if you are
connecting to the same device.
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— When TRU is in Simple Terminal mode, it just opens the port. TRU does not try to detect the hardware

connected to the port, nor change the port settings.
— When TRU is in Receiver Managing mode, it attempts to detect the device connected to the port.

— When detecting a receiver, the Detecting Receiver dialog box displays. An ActiveSync animated icon
and the Cancel button displays. Additional parameters display when using serial transport, i.e., baud

rate and flow control.
— When TRU is in Modem Managing mode and auto detection is setup, it tries to detect a modem at the time
of connection. If there is no modem, or if it does not respond, a connection cannot be established.

— When detecting a modem, the Detecting Modem dialog displays identical to the Detecting Receiver
dialog box.
Click Cancel to terminate the process.

uoljpauuo)

Disconnection Auto Detection

When in Receiver Managing or Modem Managing modes, TRU periodically checks if the device is still connected by
obtaining the receiver ID. If connection to the device is lost, an error message displays !

TRU then closes the established connection and makes the tool area inactive. TRU does not try to reconnect to the
device.

1. A connection to the receiver was lost.
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You must choose an appropriate application mode and transport, then initialize a new connection by selecting Device
» Connect from the Main Window.

Disconnection auto detection does not work when in:

@QS - Simple Terminal mode while using any tool
~

- Receiver Managing mode while using the Terminal or Firmware Upload tool
- Modem Managing mode while using any tool

uoljpauuo)

When using a Bluetooth or USB connection the operating system notifies TRU that the connection has
<//\/>@ physically been broken (e.g., the remote device was switched off). In that case, TRU also closes the
established connection irrespective of the current application mode or active tool.
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Simple Terminal

Simple Terminal mode provides flexibility to connect with receivers through manual commands. Use of this mode is intended
for advanced users and can be really useful if you want to connect to a device that is not supported by TRU.

Note that Simple Terminal mode does not enable the following functionalities:

— Device detection
— Port setting changes
— Data transmission to the port

- To make the tool area active, first establish a port connection on the controller using the Connect option
-~ from the Device menu. See “Connection” on page 8.

In the Main Window the following icon is available.

The Terminal icon allows you to communicate with any device in manual mode. You can record data to a file from
a connected device.
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Terminal Parameters

Click the Terminal icon - to open the Terminal dialog box.

M Terminal E@g

4
3
=
()
o
=
3.
J
=&

Edit Area/Drop-down —— | | M Sendl B ||| <@—— Menu Icon

Status —p [l| #CTS ®DSR @ RING @ RLSD

Figure 13: Terminal Dialog Box
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The Terminal screen allows you to send commands through the selected port using the Edit Area at the bottom of
the dialog box, and the Send button. The Edit Area remembers previous commands, which you can select from the
drop-down list at the bottom of the dialog box.

The Status Bar in the lower part of the dialog shows the current state of transport for specific signals.

The Menu icon |E in the lower right corner of the Terminal dialog box opens the pop-up menu with the following
options:

Clear View — clears the main view.

Send File — sends a file that contains either commands or binary data. This option sends files as is. TRU does
not change encoding or charset, add carriage returns or line feed characters.

Send File (XMODEM Protocol) — sends a file using the XMODEM protocol.
Escape Functions — opens the Escape dialog box to send transport specific commands.

Port Settings — opens the Port Settings dialog box to adjust port settings. When TRU is in Simple Terminal
mode, it does not change port settings.

Port settings depend on the operating system:

<//\,>QS — Usually the operating system for the PC remembers the previous port state, so if the port

baud rate is changed, the assigned value is kept.

CE.NET and Windows Mobile usually reset port settings to their default values; therefore, if you open
a serial port next time, you have to adjust port settings again.

Simple Mode —
— If the Simple Mode item is selected, the terminal works in a similar way as a traditional terminal
application, such as HyperTerminal. Every time you press a key, the key code is immediately sent to the
connected device.

Terminal Parameters P/N: 7010-0908

4
3
=
()
o
=
3.
J
=&




— When the Simple Mode item is not selected, and you compose a command in the edit box, you must click
either the Send button or Enter to send the text (followed by a carriage return and line feed) to the
connected device.

* ASCII/HEX - toggles text/HEX mode.
* Text Size — sets the size of the text (Largest, Larger, Normal, Smaller, Smallest).

* Bytes in a Row (HEX Mode) — selects the number of bytes in a row, and optionally displays the left hand (data)
pane and the right hand (character) pane. This option only applies to HEX mode.

e Start Logging — initiates writing all the data received from the device to a file.
* Stop Logging — stops writing data received from the device to a file.

jeuiuia] ajdwis
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Receiver Managing

Use Receiver Managing mode to configure Topcon GNSS receivers.

When in Receiver Managing mode, TRU tries to detect a receiver at the time of connection. If there is no receiver or if it does
not respond, a connection cannot be established. For more information on connecting to your device, see “Connection” on
page 8.

In Receiver Managing mode, the following icons display in the tools area of the Main Window:

Allows you to communicate with a receiver in manual mode. You can record data to a file from a connected
device.

% Displays essential information about the receiver.
|

Displays information about receiver options and allows you to upload OAF files.

Resets the receiver, its settings, and RTK engine.

Receiver Managing P/N: 7010-0908 29



E“‘ Opens a submenu with tools to configure the receiver.

Displays the receiver status (coordinates, list of satellites, sky plot, etc). You can also use this control to record
) data to a file from a connected receiver.

Manages log files (deleting, downloading, uploading, and restoring deleted files), initializes file system, and
\Eﬂ.- displays information about file system and the memory card.

E Displays internal modems, detects new modems, and manages cell modem drivers.

Terminal

Click the Terminal icon ! to open the Terminal dialog box.

P/N: 7010-0908
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Figure 14: Terminal Dialog Box

The Terminal screen allows you to send commands through the selected port using the Edit Area at the bottom of
the dialog box and the Send button. The Edit Area remembers previous commands, which you can select from the
drop-down list at the bottom of the dialog box.

The Status Bar in the lower part of the dialog box shows the current state of transport for specific signals.
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The Menu icon |E in the lower right corner of the Terminal dialog box opens the pop-up menu with the following
options:
* Clear View — clears the main view.

¢ Send File — sends a file that contains either commands or binary data. This option sends files as is. TRU does
not change encoding or charset, add carriage returns or line feed characters.

* Send File (XMODEM Protocol) — sends a file using the XMODEM protocol.
* Escape Functions — opens the Escape dialog box to send transport specific commands.

* Port Settings — opens the Port Settings dialog box to adjust port settings. When TRU is in Simple Terminal
mode, it does not change port settings
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Port settings depend on the operating system. Usually the computer’s operating system remembers
//,@ the previous port state, so if the port baud rate is changed, the assigned value is kept. CE.NET and
- Windows Mobile usually reset port settings to their default values, so the next time you open a serial
port, you must adjust the port settings again.

* Simple Mode - if the Simple Mode item is checked, the terminal works in a similar way as a traditional
terminal application, such as HyperTerminal. Every time you press a key the key code is immediately sent to the
connected device.

When the Simple Mode item is not selected, you compose a command in the edit box, and then click either Send
or press Enter. The entered text (followed by carriage return and line feed) is sent to the connected device.

* ASCII/HEX — toggles text/HEX mode.
* Text Size — sets the size of the text (Largest, Larger, Normal, Smaller, Smallest).

* Bytes in a Row (HEX Mode) — selects the number of bytes in a row and optionally displays the left hand (data)
pane and the right hand (character) pane. This option only applies to HEX mode.

* Start Logging — initiates writing all the data received from the device to a file.
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* Stop Logging — stops writing data received from the device to a file.

There is only one difference between Terminal in Simple Terminal mode and Terminal in Receiver
@gg Managing mode. While in Simple Terminal mode you have to manually adjust port settings (for a
serial cable connection). In Receiver Managing mode, TRU automatically adjusts the port settings.

Information

Click on the Information icon % to view receiver information.

The Receiver Info dialog box displays basic receiver information (hardware, firmware versions, RAM size etc.) about the
currently connected receiver.

<//\/>g Parameters not supported by the connected receiver are not shown.

* Refresh — refreshes the parameter list.

* Save to File — saves the receiver parameters and options to a text file. By default the TRU sets the <receiver
ID>.txt file name.

P/N: 7010-0908
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Options
]
Click on the Options icon z=== to manage receiver options.

The Receiver Options dialog box shows you the current/purchased/leased authorization options and uploads OAF
files.

* Option Name — displays a name for the receiver option.
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@gg The options list depends on the firmware version loaded into the receiver.

* Internal Name — displays a name for the receiver option in a GRIL convention.

* Current — indicates the current value of the option.

* Purchased — indicates the purchased value of the option.

* Leased — indicates the leased value of the option.

* Exp. Date - indicates the date the leased option is expired.

* Refresh — refreshes the options list.

* Upload OAF — uploads a new OAF file. By default, TRU offers to use the <receiver ID>.tpo file name.

* Save to File — saves the options list to a text file. By default, TRU sets the <receiver ID>.opt.txt file name.
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Upload OAF

1. After clicking the Upload OAF button from the Receiver Options dialog box, navigate to the location of a file
that contains new authorization options for the receiver and select the desired file.
Then the Upload OAF dialog displays the full path name and information about the selected OAF file.

2. Click the Open Folder icon to select another OAF if needed.
3. TRU initially checks if the file you selected is compatible with the connected receiver:

— If you chose a file not intended for this receiver, TRU displays an error icon in front of Receiver ID and
disables the Upload the File to the Receiver button.

— If the Upload the File to the Receiver button is available, click it to start loading the file. The content of
the dialog box changes. It shows the options that have been installed with the new OAF and the progress
bar.

— It is possible that on some receivers, option hame or loading results may not display during the update
process; however, SRU displays a message box informing you about the result when the OAF loading
process is finished.

— If an OAF file is uploaded to the receiver, TRU offers to reset the receiver to apply new authorization
options.
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Tools
The Tools icon 4f  opens the Send Command dialog box that allows you to perform different resets and other
power related operations, listed below, on the receiver.

* Reset Receiver — performs a hardware reset that is functionally equivalent to power cycling the receiver.
Resetting the receiver leaves all receiver parameters and files intact.
Typical use of this tool is to apply certain settings that require a hardware reset. After completing this operation,
the receiver requires from a few seconds to a few minutes to begin tracking satellites and logging data.
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* Factory Reset — resets all the receiver parameters to their default values and clears the receiver’s Non-Volatile
Random Access Memory (NVRAM). NVRAM holds data required for satellite tracking, such as ephemeris data
and position, and also keeps the current receiver’s settings, such as active antenna input, elevation masks, etc.
Factory Reset does not delete any files from the receiver and does not reset modem parameters.

This is typically used after loading a new firmware file and sometimes to eliminate communication or tracking
problems. After performing this procedure, the receiver requires some time to collect new ephemerides and
almanacs (up to 15 minutes).

* Reset Parameters — resets all the receiver parameters to their default values. This operation does not delete
files, almanac, and ephemerides from the receiver and does not reset modem parameters.

* Reset RTK - resets the RTK engine.
e Power Off — turns the receiver off. You cannot turn on the receiver via TRU.

* Sleep — puts the receiver into sleep mode. The receiver enters into sleep mode immediately after you click Yes
on the confirmation prompt and stays in this mode until you turn on the receiver manually or the receiver detects
any activity on one of the serial ports.

* Reset VISOR - resets the VISOR engine.
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Receiver Settings

The Receiver Settings icon E‘"‘ opens a submenu, which contains a set of tools for receiver configuration.

The Back icon returns you to the Main Window.

&

Manages receiver tracking parameters such as antenna type, tracking signals, etc.
This tool consists of the following tabs: Signals, Antenna, Obs, Adv, Msint, GPS, GLONASS, Galileo, BeiDou, SBAS,
QZSS, and OmniSTAR.

L

Manages positioning mode and desired solution type.

- g Displays and configures receiver ports.
—2 Manages power output to internal slots.
-

iy

Receiver Settings

P/N: 7010-0908
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Runs RTK operations without using an external interface to localize the base receiver.

(a Manages volume parameters of HiPer II and HiPer V receivers.

9 Displays and configures Bluetooth parameters.

Manages SIM cards for the HiPer SR+ Receiver.

Sui8eueyy 1an1909Y

Tracking

Click the Tracking icon & ‘3 to manage receiver tracking parameters, such as antenna type, tracking signals, etc.
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Signals
Specify which satellite signals that you want the receiver to track. The following signals are available:

* GPS P - satellite signals in the GPS P1 and P2 channels.

¢ GPS L2C - satellite signals in the GPS L2C channel.

* GPS L5 - satellite signals in the GPS L5 channel.

* GLONASS P - satellite signals in the GLONASS P1 and P2 channels.
* GLONASS L2C — satellite signals in the GLONASS L2C channel.

* QZSS L2C - satellite signals in the QZSS L2C channel.

* BeiDou B2 - satellite signals in the BeiDou B2 channel.
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Antenna

The Antenna tab changes the tracking antenna type used with the connected receiver (either Internal, External, or
Auto) if the connected receiver is capable of tracking satellites with internal and external antennas.

The Current Input control shows the antenna type currently used with the connected receiver: Internal or External.

Observations

The Obs tab changes parameters for satellites observation. The appearance of this dialog box depends on the RTK
Engine version.
* Elevation Mask — configures various elevation masks in degrees, specifically:

— Satellites Tracking — Defines the minimum angle at which the receiver tracks satellites. The default value is
5 degrees.

— Position Computation — Defines the minimum angle at which the receiver uses satellites for position
computation. The default value is 5 degrees.
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— RTK Computation — Defines the minimum angle at which the receiver uses satellites for the RTK position
computation. The default value is 10 degrees.

* PDOP mask — configures various PDOP values for satellites used in computation:

— Position Computation — the receiver does not compute positions over the corresponding epochs while PDOP
exceeds the entered threshold value. The default is 30.

— RTK Computation — specifies the PDOP mask used in RTK position computation. The default value is 3.5.

Advanced

The Adv tab allows changing advanced signal processing parameters.
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* Anti-jamming — if available for the connected receiver, enables suppression of narrow-band interference for GPS,
GLONASS, L1, L2 signals, for auto-detected or manually selected bands affected by interference.

* The Anti-jamming manual settings button opens the Anti-Jamming Manual Settings dialog. Use it to
manually configure which RF bands to monitor for the interfering signals.

* C/A code multipath reduction — when selected, enables the use of a special signal processing technique for
reduction of C/A code phase multipath.

¢ C/A carrier phase multipath reduction — when selected, enables the use of a special signal processing technique
for reduction of C/A carrier phase multipath.

* Cinderella — when selected, enables the Cinderella option which sets all receiver options to their maximum
allowable values for 24 hours every other Tuesday at GPS midnight.

<//\/>@ If the Cinderella option has been changed, reset the receiver to apply changes.
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* Quartz Lock Loop — enables or disables the Quartz Locked Loop (QLL).
For more information on QLL and how it can benefit your system operation, visit OEM technology section at
http://oem.topconpositioning.com

Raw Measurements and Position Update Rates

The Msint tab contains settings for specifying the rate at which the receiver updates raw measurements and positions.
The range of allowed values depends on the firmware version, hardware, and the current receiver options.

* Raw measurements update rate — determines the rate at which the receiver generates pseudoranges, carrier
phases, and some other GNSS observables.

* Position update rate — determines the rate at which the receiver updates the position.

GPS

The GPS tab enables or disables the receiver to track and use specific GPS satellites. You can choose GPS satellites
used for tracking and position computation by selecting specific satellite check boxes or by using the pop-up menu.

GLONASS

The GLONASS tab enables or disables the receiver to track and use specific GLONASS satellites. You can choose
GLONASS satellites for tracking and position computation by selecting specific satellite check boxes or by using the pop-
up menu. The pop-up menu also enables you to change the presentation of GLONASS satellites. You may choose either
USI or FCN numbers.

A
M
0
o,
<
o
=
<
o))
3
Q
£y
=
09

Galileo

The Galileo! tab enables or disables the receiver to track Galileo satellites. Tracked Galileo satellites can be selected
using the checkboxes or the pop-up menu.
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BeiDou

The BeiDou! tab enables or disables the receiver to track BeiDou (COMPASS) satellites. Tracked BeiDou satellites can
be selected using the checkboxes or the pop-up menu.

SBAS

The SBAS tab allows configuring WAAS/EGNOS/MSAS.

To make the receiver track a SBAS satellite, select the corresponding SBAS USI (Universal Satellite Identifier). The
following USI's are allocated to SBAS satellites.
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System Name usi NMEA Satellite ID

WAAS AOR-W 122 | 35 (Phased out July 30th, 2007)

Anik 138 51 (New WAAS satellite)

POR 134 47 (Phased out July 30th, 2007)

PanAm 135 48 (New WAAS satellite)

EGNOS AOR-E 120 33

1. Refer to the receivers' brochure or manual for more information on supported constellations and signals. Some Sokkia receivers are Galileo
and BeiDou ready systems; full support of these new constellation(s) and associated signals will be made available on these receivers via an
FW/OAF upgrade.
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Artemis 124 37
IOR-W 126 | 39
IOR-E 131 | 44
MSAS MTSAT-1 129 | 42
MTSAT-2 137 50

* Tracked Satellites — lists USI's of all SBAS satellites. Select the corresponding check boxes to allow the receiver
to track selected SBAS satellites. Use the pop-up menu options to enable or disable all satellites.

* Interpret message #0 as — enables and disables the receiver to use any data from SBAS satellites if message
type 0 is being broadcast.

— 0: the receiver does not substitute message type 0 and therefore does not use any data from the SBAS
satellite.

—[1...99]: the receiver substitutes the selected message type for message type 0 and therefore interprets
message type 0 as a message with the selected type.

¢ Use Iono Corrections — enables and disables the receiver to apply ionospheric delay corrections broadcast by a
SBAS satellite to the GPS satellites.

For none Vanguard, G3 and TG-3 based receivers, the SBAS screen provides the setting True SBAS USI number. With
this setting enabled, the receiver outputs true USIs in SI messages rather than associated with a GPS USI.

Q1SS
The QZSS tab enables you to configure the Quasi-Zenith Satellite System (QZSS).
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Tracked Satellites — lists USI's of all QZSS satellites. Select the corresponding check boxes to allow the receiver to track
selected QZSS satellites. Use the pop-up menu options to enable or disable all satellites.

OmniSTAR

The OmniSTAR tab configures the OmniSTAR engine in the receiver. OmniSTAR is a wide-area differential GNSS
service provider.

OmniSTAR corporation to receive a subscription authorization.
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@@S OmniSTAR correction signals are proprietary, and you need to purchase a subscription from the

e VBS Engine:
Enable: Enables VBS engine.

¢ HP Engine:
Enable: Enables HP Engine.

Wait VBS: If this option is enabled, the HP Engine does not start until a VBS solution is received.

* Nominal Frequency and Symbol Rate:
Nominal Frequency: Nominal carrier frequency [Hz] of beam as entered by the user.

Symbol Rate: Symbol rate of beam as entered by the user.

You can change the nominal frequency and symbol rate. In the OmniSTAR Satellite Selection dialog box,
you can either select a satellite from the list or enter the nominal frequency and the symbol rate manually.

* The Information button displays information about the OmniSTAR subscription: the receiver Fugro ID, the
library version, and the date of Subscription End for both VBS and HP engines.
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Positioning

Click the Positioning icon Vil to manage positioning mode and the desired solution type.
|

General Parameters

The General tab allows you to change positioning mode and enabling solutions:

* Positioning Mode — selects a positioning mode for the receiver.
* Enable Solutions — selects the type of solution to use for Rover receivers.

— Standalone: for a Rover receiver operated in differential mode, reports the current standalone position if a
DGPS (or RTK) position is unavailable in the current epoch.

— Code Differential (DGPS): for a Rover receiver run in RTK Float or RTK Fixed mode unable to obtain an RTK
solution at the current epoch, outputs the current code differential position. If enabled and you cannot
obtain a Code Differential solution, enable Standalone to have the receiver output single-point positions for
the unavailable differential positions. This mode requires the Base (Reference) receiver to broadcast Code
Differential (not RTK) messages and the Rover receiver to receive these messages. If either of these
requirements is not met, enabling Code Differential has no effect.

* DION: selects mode in which the DION engine operates. DION is an enhanced absolute positioning engine that
allows you to use a single Topcon receiver to compute smoothed and consistent position solutions. Instead of
using instantaneous yet rather noisy pseudorange measurements of an ordinary single point positioning, you

can activate the DION engine to get more accurate and reliable results without the requirement of any additional
hardware or software.

— Off: the DION engine is disabled.
— Local: the DION engine provides precise positioning with respect to a starting point.

— Smooth: the DION engine provides smoothed estimates of absolute positions using refined delta positions
from carrier phase processing.
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RTK Parameters

The RTK tab allows setting up the RTK rover.

* RTK Mode — Position output mode. Controls which output mode is enabled. Default value: Delay.

— Delay: the RTK engine does not extrapolate the base station's carrier phases in position computation.
Instead, the engine either computes a delayed position or simply output the current stand-alone position
(while waiting for new RTK messages from the base station). Note that the delayed position is computed for
the time (epoch) to which the last received base station's carrier phase measurements correspond.
Accuracies achievable in delay mode are normally on a level with those of post-processing kinematic.

— Extrapolation: the RTK engine extrapolates the base station's carrier phase measurements to the current
epoch (note that the truth carrier phases measured at the base cannot be transmitted and received at the
rover instantly). The final positioning accuracy may be somewhat lower due to additional extrapolation
errors, which may be up to a few millimeters vertical and horizontal for a one second extrapolation time.
Note that extrapolate mode could be used only when the reference station is static (i.e., not moving).

* Extrapolation Time, s - Maximum extrapolation time. In extrapolation mode, if the time elapsed since differential
corrections were last received exceeds this value, RTK stops calculating positions. Default value: 30 seconds.

* Base Corrections Period, s - Differential correction update interval (period) for reference station. Instructs the
rover receiver to output the RTK position (not the single point position) at the same rate at which differential
corrections are updated. Default value: 1 second.

* Dynamics - User defined rover dynamics.
— Static: the engine uses a running average over a few consecutive solutions to decrease the resulting
position's noise error.
— Kinematic: the engine uses only the current epoch of observations to compute the instantaneous position
(i.e., no averaging is performed).
— Stop And Go: the new RTK engine monitors the rover dynamics and automatically selects between static
and kinematic models. The receiver immediately switches to kinematic in two cases:
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a. if the difference between previous and current instantaneous position estimates changes over 3
centimeters in 3-D vector components;

b. if the difference between an averaged position estimate and a current instantaneous position
estimate changes over 4.5 centimeters in 3-D vector components.

* Ambiguity Fixing Level - Specifies a level of confidence when fixing integer ambiguities. The RTK engine has 3
levels of confidence when fixing integer ambiguities, Low, Medium and High which correspond to the indicator's
95%, 99.5% and 99.9% thresholds, respectively.

The higher the confidence level specified the longer the integer ambiguity search time.

Assume you have set this parameter too high. The receiver's RTK engine constantly updates the confidence level
indicator as new measurements arrive. Once this parameter exceeds the 99.9% threshold, the engine fixes up
all or some of the integer ambiguities. The corresponding position estimate is marked as fixed RTK solution
although some of the ambiguities (usually a small part of them) may remain float. Default value: Medium.
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Advanced RTK Parameters!

The Adv. RTK tab is designed to tune the RTK engine.

* VRS Mode - Enables or disables the receiver VRS mode.
— Enabled (checked) — RTK assumes that the reference station in use is Virtual Reference Station (VRS).
— Disabled (unchecked) — RTK assumes that the reference station is a real one.

* IF Baseline, m — The threshold value for the RTK ionospheric modeling. The ionospheric delay is modeled by
RTK only if the baseline length is greater or equal to the specified value. Default: 4000 meters (old RTK), 20000
meters (new RTK).

* Weighting Based On Residuals — Controls applying weights to measurements based on VRS residuals (RTCM 3.1
MT1030, MT1031). Default: Disabled.

1. These settings are intended for advanced users only and must be left at their default value unless otherwise instructed by technical support
personnel associated with your local distribution and/or Topcon.
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¢ Maximum Residual Value, mm - Threshold in [mm] for rejecting measurements based on value of VRS residual
(RTCM 3.1 MT1030, MT1031). "0" means no rejection. Default: 0.

Base Station Parameters

The Base tab enables you to configure a reference base station.

* Antenna Type — Antenna type descriptor for RTCM 2.3 and 3.0. The Antenna Type combo box is populated with
values, which are read from the receiver antennae database.

* Base Station Coordinates — This parameter specifies coordinates of the Antenna Reference Point or Phase Center
L
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Coordinates of ARP and Phase Center L1 are interrelated. When a valid Antenna Type is selected,
@@ secondary (not selected) coordinates are calculated based on information about the selected
- antenna from the receiver database. When no antenna is selected or the receiver database does not
contain information about the antenna, secondary coordinates are set equal to primary (selected)
ones.

HD2 Parameters

The HD2 tab allows you to configure a rover receiver in a dual-receiver setup for a 2-D attitude determination.

¢ HD2 Rover — enables the receiver to compute 2-D attitude parameters, heading, and inclination.
* Distmode — instructs the receiver to compute and use the inter-antenna distance for 2-D attitude determination.

* Smoothing — enables the receiver to smooth heading results. You can specify the highest possible accuracy in
radian with which the receiver will smooth the heading. The smaller the value, the greater the smoothness of
the heading.

You can view computed 2-D attitude parameters. See “Heading” on page 67.
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VISOR Parameters

The VISOR tab allows you to configure the MR-1 receiver/OEM-1 board for 2-D attitude determination (heading and
inclination).
* VISOR Engine — enables the receiver to compute 2-D attitude parameters and select the initialization type. The
following types are available:
— Velocity Vector — initializes VISOR by moving the platform with rigidly mounted antennas.
— Twin Antenna Rotation — initializes VISOR by rotating a platform with rigidly mounted antennas in a plane
parallel to horizon.
— Manual — enters initial heading and inclination with the GRIL command.
— Auto — initializes using initial heading and inclination computed by the auxiliary RTK engine running in the
background.

* Baseline — specify the inter-antenna distance in Length. Check the Distmode setting to instruct the auxiliary
RTK engine to compute and use the inter-antenna distance.

¢ Advanced — specify some advanced VISOR settings. See “Advanced VISOR Parameters” on page 50.
You can view computed 2-D attitude parameters at “Heading” on page 67.

For more information about VISOR configuration, limitations, and guidelines, see the OEM-1 Integrator’s Guide,
Enabling VISOR and Understanding Results.

Sui8eueyy 1an1909Y
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Advanced VISOR Parameters

* Initial Angles — specifies the initial values of heading and inclination formatted as decimal degrees. These values
are used in the initialization type manual.

* Shifts — specifies the heading and inclination offsets formatted as decimal degrees. These values are used in the
initialization type Velocity Vector.

* Advanced — configures line bias estimation, smoothing, and only heading.
— Dlock — enables the receiver to save the estimated line biases to the NVRAM.

— Adaptive Smoothing — enables the receiver to use an adaptive smoothing for the slowly changing or
constant attitude parameters.

— Heading Only — enables the receiver to estimate only one attitude parameter — heading.
You can view computed 2-D attitude parameters at “Heading” on page 67.

A
M
0
o,
<
o
=
<
o))
3
Q
£y
=
09

For more information about VISOR configuration, limitations, and guidelines, see the OEM-1 Integrator’s Guide,
Enabling VISOR and Understanding Results.

Ports

= s

The Ports icon
receiver.

opens the Receiver Ports dialog box, which displays all ports available in the connected

TRU, with the Base license, supports Serial, USB, Network, Bluetooth, and Ntrip ports (expand the tree for details).
Double-tap a desired port name or use the pop-up menu to change settings of the selected port.
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Receiver Ports

For Serial, USB, TCP, Bluetooth, and Ntrip ports, you can change Input Mode, Output Mode, and Period. You can also
view and edit a set of messages, which are output to the port.

e Input Mode: specifies the type of data to input on the selected port:
— none: the port rejects any incoming data
— cmd: the port is in command mode and recognizes user-sent commands

— echo: the port is in echo mode and redirects all incoming data to an output stream, either another port or
the current log file

— rtcm: the receiver recognizes and decodes RTCM version 2.1, 2.2, and 2.3 messages accepted on the
corresponding port

— rtcma3: the receiver recognizes and decodes RTCM version 3.0 messages accepted on the corresponding
port

— cmr: the port recognizes and decodes accepted CMR messages

— jps: the port recognizes and decodes accepted TPS messages

— omni: the port recognizes and decodes OmniSTAR VBS corrections

— dtp: the port is in Data Transfer Protocol mode, which is used for data transfer to/from the receiver

— term: the port is in PPP mode
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To connect to the receiver through a port, input mode of the port should be command (cmd).

~
& You may not modify input mode of the port, which you are currently using to connect to the receiver.
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— Output Mode: specifies a predefined message set to output into the selected port. The following o)
predefined message sets are available: 2
g.
Message Set/Output Mode Messages Period, s Q
DGPS RTCM 2.x 1 Variable §
31 Variable o%
3 10 o%
RTK RTCM 2.1 18 Variable
19 Variable
22 10
3 10
59t 10
RTK RTCM 2.3 18 Variable
19 Variable
23 10
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Message Set/Output Mode Messages Period, s
24 10
59t 10
RTK RTCM 3.x 1004 Variable
1012 Variable
1006 10
1008 10
1033 10
RTK CMR 10 Variable
0 Variable
1 10
5 10

Receiver Settings
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Message Set/Output Mode Messages Period, s §
RTK RTCM 3 MSM 1074 Variable §
1084 Variable 2
1114 Variable §
1124 Variable =
1006 10 -
1008 10
1033 10
RTK CMR+ 10 Variable
0 Variable
9 Variable
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Message Set/Output Mode Messages Period, s

HD2 TPS RT Variable
SI Variable

rc Variable

2r Variable

cp Variable

2p Variable

PO Variable

ET Variable

NMEA GGA Variable
GSA Variable

ZDA Variable

VTG Variable

Receiver Settings
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* Period, s: specifies in seconds the interval at which the receiver generates messages included into the currently
selected predefined message set (Output Mode), in seconds.

* Messages: opens the Messages dialog box to configure output messages on the corresponding port manually.

Serial Ports

Serial ports have additional settings, which can view and modify on the Serial property screen.
* Baud Rate, Byte Size, Stop Bits, Parity: serial port parameters for communication with an external device
connected to this port.

* RTS/CTS: enables/disables hardware handshaking for the port (if enabled, make sure that the external device
supports this mode).
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Network Settings

The Network Settings dialog box (Network » General Settings) allows editing general network settings:

¢ IP Address: Identifies the receiver on a TCP/IP network by specifying its IP address.
* IP Mask: Specifies the network mask.

* Gateway: Specifies the gateway.

* Password: Sets a password for telnet-like TCP connections.

FTP Settings
The FTP Settings dialog box (Network » FTP » General Settings) allows editing FTP related settings:
* FTP Port: Specifies the TCP port the receiver is listening on for FTP connection. Values: 1...65535. Default value:
21.

* Timeout, s: Specifies a period of time that must elapse before an inactive connection terminates. Values: 1...231-
1 seconds. Default value: 600 seconds.
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TCP Settings

The TCP Settings dialog box (Network » TCP » General Settings) enables you to edit global TCP settings (which
are not related to a specific TCP port of the receiver):
* TCP Port: Specifies the TCP port number on which the receiver is listening on for raw TCP connections. Values:
1...65535. Default value: 8002.

* Timeout, s: Specifies the amount of time that the TCP server waits for data before terminating TCP connections.
Values: 0...2000 seconds. Default value: 0 seconds.

* Enable Authentication: Specifies whether you need to enter the password when accessing the receiver via a raw
TCP port.
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If the GNSS firmware supports individual TCP Port and Enable authentication settings for each TCP
////@ port of the receiver, the TCP Setting dialog box does not contain these settings. The TCP Port Settings
property sheet for each TCP port of the receiver contains a screen with individual settings for the port.

Messages

Use this dialog box to configure output messages on the corresponding port manually.

The pop-up menu enables you to add, edit, or remove messages. The receiver keeps the customized message set in
the NVRAM for further usage.

* Add new messages: opens the Receiver Message List dialog box to add new messages to the message list.
You can select one or more messages to add to the list of messages, which is sent to the selected port.

* Edit message: opens the Receiver Message dialog box. In this dialog box you can specify the schedule of the
message. The Schedule Specification fields are used to define the output scheme for the message.
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* Delete messages: removes selected messages from the list. o)
* Delete all messages: removes all the messages from the list. 2
()
Receiver Message List S
4
The Receiver Message List dialog consists of upper tree control and lower list control. The tree control displays all <
the messages supported by the currently connected receiver. The list control displays the messages to be added. g
To add a message from the upper tree control to the lower list control you can double-click it, press <space> or use 0%
the pop-up menu. 5
0Q
You can change the order of the messages in the list control using the clipboard. The computer
// .
= version also supports the drag-and-drop method.

Receiver Message

In this dialog box you specify the schedule of the message. The Schedule Specification fields are used to define the
output scheme for the message.

* Period: specifies the message output interval. If set to zero, the corresponding message outputs at the highest
possible rate.

* Phase: specifies a time shift in the output of a message with respect to the moment when the receiver time is
a multiple of the specified period.
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* Count: serves two purposes. First, if set to a positive number, specifies how many times the message outputs.
Zero means an unlimited number of times the message outputs. Second, if set to a negative number, instructs
the receiver to encapsulate a message into >> message before output.

* Flags: provides further adjustment of the way the message is output. They are briefly explained below.

Flag Description

Out If the flag is selected, the first of the messages invoked by the corresponding command outputs at
the epoch closest to the command execution time (whatever the specified "period" option).

Change If the flag is selected, the corresponding message outputs only if the message data have changed.

Out On Add If this flag is set, then the (first) message outputs immediately after executing the corresponding em
or out command.

Notena The receiver uses this flag in order not to output the file header every time you change the "period"
value when recording data into the log file.

Fix Per If these flags are selected, you cannot change the option values (Period, Phase, Count, and Flags).

Fix Ph

Fix Cnt

Fix FI

Messages
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Bluetooth (HiPer SR only)

The Bluetooth branch enables you to configure the Bluetooth ports of the HiPer SR receiver.

* Bluetooth Serial Ports: Bluetooth Serial Port, which accepts one incoming connection from a remote device.
For the HiPer SR Rover this is the port to which the computer or field controller is connected. For the HiPer SR
Base, this is the port that either the PC/Field Controller or the HiPer SR Rover is connected to when configuring
the base.

* Bluetooth Client Ports: Bluetooth Client Port which is available when the outgoing connection is established
by the Bluetooth Client. When enabled, the Bluetooth Client tries to establish a connection to the remote
Bluetooth device port according to current Client settings. This port is used in the HiPer SR Rover configuration
to maintain connection to the HiPer SR Base - either to configure it or to receive corrections.

* Bluetooth Service Ports: Bluetooth Service Port used to accept up to three incoming connections and provide
services (i.e. corrections) to remote devices. This port is used in the HiPer SR Base configuration. Corrections
enabled on this port transfer to the Bluetooth Client port of the connected HiPer SR Rover.
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Power

The Power icon ™= opens the Power dialog box, which sets power output on the internal slot.

iy

* Slots: governs power output to the receiver’s internal slots (the slot hame is shown below).

—y: when the receiver is on, the internal slot receives power. If the receiver is turned off, no power is sent to
the slots.

— n: the internal slot is not powered, even if the receiver is turned on.
— always: the internal slot is powered even if the receiver is turned off.
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* Miscellaneous:

— Enable power up script: available for selection only for Topcon HiPer II and HiPer V receivers. Enables the
receiver to power up by a script file loaded into the receiver.

Power (HiPer SR Cellular Model Only)

The Power icon opens the Power dialog box, which manages power output (on/off setting) for the integrated cellular
model.

Auto Seed

The Auto Seed icon @ opens the Auto Seed dialog box, which enables the Auto-Seed functionality for the base
receiver.
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The Auto-Seed feature provides you the ability to quickly setup and begin RTK operations without using an external
interface to localize the base receiver. You just set up over a mark and power up. The base receiver automatically selects
a new position gathered by autonomous averaging and saves it for later re-occupation. If the point has been previously
occupied and the receiver position falls within proper tolerance, it selects a point from positions stored in memory.

* Enable Auto Seed: when selected, enables the Auto-Seed functionality.

* Maximum distance: tolerance for the distance from the previously occupied point.

* Enable averaging mode: when selected, enables averaging autonomous positions for a occupation point.

* Position averaging interval: sets the interval for autonomous averaging

* View the point list: opens a list of previous occupations saved in the receiver memory.
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Point List

The Auto Seed, Point List contains information about all occupations which are stored in the receiver memory:
names, date and time, coordinates of phase center and/or antenna reference point, whether the point was auto
determined and protected from deleting.

Hold your stylus on a highlighted point line in the list to open a context menu. This menu performs various operations
on the point list:

Auto Seed

Add New Point: opens a dialog box to add a new point.

Edit Point: opens a dialog box to edit information on the highlighted point.

Delete the point from the list: erases the selected point in the list if it is not protected.

Delete all the points: deletes all points except protected ones.

Enable/Disable point protection: enables/disables protection of the selected point from deleting.
Refresh: renews the list

Export the point list: opens a dialog box to select an XML file in which to export the point list.
Import the point list: opens a dialog box to select an XML file from which to import a point list.
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Add New Point

Enter the name of the new point. Select the Auto check box to enable the averaging mode to auto detect the
coordinates of the phase center.

Click the corresponding |:| button to enter the appropriate coordinates in the Cartesian Coordinates dialog box.
You can also use this dialog box to edit the coordinates of existing points.

You can enter the coordinates manually or you can use the coordinates obtained from the receiver in
@@ real time. When the second option is chosen, TRU gets the current coordinates from the receiver
every second, and then averages them unless you click Stop or OK.
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- Antenna Reference Point and Phase Center L1 coordinates are interconnected. When one coordinate
2 is change, the other one is calculated based on the current antenna offsets.

Volume Control

The Volume Control icon ﬁa opens the Volume Control dialog box, which allows you to adjust the volume level
of the sounds on various receiver operations. This feature is available only for Topcon HiPer II and HiPer V receivers.

Hold your stylus on the slider and drag it in the bar to the left or right to turn the sound low or loud, respectively.
Holding the stylus on the highlighted Sound name opens a context menu that contains three options:

* Master volume: opens a dialog to set the volume for all sounds at a time.
* Play sound: plays the selected sound.
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¢ Refresh: renews the sound volume
Master Volume

Use this dialog to set the volume for all sounds at one time.

Bluetooth

The Bluetooth icon ea opens the Bluetooth dialog that allows changing parameters of the receiver Bluetooth
module and accessibility options:
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* Name: user-friendly name of the receiver.

* PIN: PIN code of the receiver.

* Encryption: when selected, secures all data sent over Bluetooth.

* Authentication: when selected, authenticates the receiver’s identity.

* Identification: shows Bluetooth module name, address, firmware base, and version

Bluetooth (HiPer Il and HiPer V only)

The Bluetooth icon opens the Bluetooth dialog box that enables you to change the receiver Bluetooth module
parameters and accessibility options:

¢ Editable Name and PIN.

* Permanent Address and Firmware.

* Bluetooth Power: when selected, turns on the Bluetooth module power.

e Multiplexing Mode: when selected, allows multiplexing data.

Bluetooth P/N: 7010-0908




Bluetooth (HiPer SR only)

The Bluetooth icon opens the Bluetooth dialog box that enables you to change the receiver Bluetooth module
parameters and accessibility options:

e Editable Name and PIN.
¢ Permanent Address.

Dual SIM Management
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The SIM Management dialog box enables you to configure dual SIM card operation supported in the HiPer SR+ receiver.
With this functionality, you can easily switch between cellular connections. Only one SIM card can work at a time.

¢ Active SIM card — Specify the SIM card the receiver will use for cellular connections. The default SIM card is SIM
1 inserted to SIM slot #1.

¢ SIM Cards Presence — Shows you whether a SIM card is present in the corresponding slot.
Status

The Status icon “* opens the Status screen with the following tabs: Position, Data Link, Heading, SV List, Sky
Plot, Scatter Plot, Position in Time, and Logging.

Position

The Position tab displays the following information:
* The current receiver date and time synchronized to GPS system time.
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¢ Solution type (Standalone, DGPS, RTK Float, RTK Fixed, DION, OmniSTAR HP, OmniSTAR XP, OmniSTAR VBS,
Variable Fixed, Variable Float). When the DION engine is working, the Smooth text is being displayed next to
the solution type.

* WGS84 measured position of the antenna L1 phase center.

* PDOP value, a factor that depends solely upon satellite geometry and is proportional to the estimated position
uncertainty.

¢ HRMS and VRMS values, the RMS (the square root of the trace of position error covariance matrix) values of the
horizontal and vertical coordinates, respectively.

* A distance between the rover and the base estimated by the RTK engine. The distance is shown in RTK
positioning only.

* The numbers of tracked satellites for each satellite system. Each satellite system is marked in a certain color.
— GPS in green (&%)
— GLONASS in yellow-orange (&%)
— Galileo in cyan (&%)
— BeiDou in magenta ()
— SBAS in purple (&)
- QZSS in blue ()

Sui8eueyy 1an1909Y

absence of “wings” on the satellite icon means that the satellite is not used in the computation for
some reason (e.g. it is below the elevation mask).

,QS The “wings” on the satellite icon designate that the satellite is used in position computation. The
<

-
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Heading

The Heading tab displays the current heading and inclination computed by HD2 or VISOR engines. The Heading
information is displayed on a dial with major and intermediate cardinal points. The Heading field and the green triangle
at the top of the dial indicate the current heading. No heading is displayed if the receiver cannot compute it.

Inclination information is displayed on a tape with a black horizon line as a zero inclination. Major inclination marks and
numeric labels are displayed at intervals of 20 degrees. Minor inclination marks are displayed at intervals of 10 degrees.
The Inclination field and the green line with a triangle at the right end indicate the current inclination. No inclination is
displayed if the receiver cannot compute it.

Data Link

The Data Link screen displays the live statistics of the data communication links used for receiving
DGNSS/RTK measurements from various sources, including physical reference stations, network software, such as
TopNET, Ntrip casters, etc.
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Use this screen to determine data loss and link viability. Based on this statistics you can see how well your data
communication link is performing.

SVs List

The SVs screen displays the list of the satellites with satellites parameters:

* SVC — satellite icon and system (constellation GPS, GLONASS, Galileo, BeiDou, SBAS, and QZSS).
e USI — Universal Satellite Identifier.
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* EL — Elevation angle in degrees. The signs "+" and "-" immediately following the elevation angle indicate that
the corresponding satellites are either ascending or descending, respectively. If a satellite is at maximum
elevation, it is marked with "A".

* AZ - Azimuth in degrees.

e L1C - Signal-to-Noise Ratio in the L1 CA channel [dB*Hz].
* L1P - Signal-to-Noise Ratio in the L1 P channel [dB*Hz].
¢ L2P - Signal-to-Noise Ratio in the L2 P channel [dB*Hz].
e L2C - Signal-to-Noise Ratio in the L2 C channel [dB*Hz].
* L5 — Signal-to-Noise Ratio in the L5 channel [dB*Hz]

* TC - Time elapsed since the last loss-of-lock in the CA channel for the corresponding satellite. This time is given
in minutes or, if the symbol ":" is specified in the column, in seconds.

¢ SS - Satellite navigation status. For a complete description of the satellite navigation status, see GRIL Appendix
D

* FCN - Frequency Channel Number (valid for GLONASS satellites only).
* SN — Satellite's orbital slot number (valid for GLONASS satellites only).

Clicking a satellite in the list opens a tool tip for the satellite. The tool tip displays all the satellite information the list
control contains; the Satellite Navigation Status is decoded to display a legible description. The tip closes after clicking
on it, or automatically after 5 seconds.
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The list of satellites is updated once a second. If TRU does not receive any information from a satellite, the satellite
does not disappear immediately from the list, but is still displayed in the paling color for 10 seconds. If there is no signal
from the satellite during these 10 seconds, the satellites completely disappear.

~ In Real-Time Logging mode, Elevation Mask for raw measurements is set. Because of this elevation
= mask, some satellites may be absent in the list. Still, they are used for position computation.

Sky Plot

The Sky Plot tab displays the graphic position of satellites on the sky.
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Each satellite system is marked in a certain color:
— GPS in green (&£F)
— GLONASS in yellow-orange (&%)
— Galileo in cyan (&)
— BeiDou in magenta (4)
— SBAS in purple (&%)
— QZSS in blue (4@)
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The “wings” on the satellite icon designate that the satellite is used in position computation. The
///QS absence of ‘wings’ on the satellite icon means that the satellite is not used in the computation for

¢ some reason (e.g. it is below the elevation mask).

The USI (Universal Satellite Identifier) of each satellite is displayed under satellite icons.
Red circle designates the elevation mask.
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Clicking on a satellite icon displays a tool tip that shows the information about the satellite.
Scatter Plot

The Scatter tab displays the receiver's trajectory/position in real time.

The scatter plot is updated each second. The current position is displayed in the form of pictogram. Each solution type
is designated by a respective pictogram.

o — Standalone, DION # — RTK Float, Variable Float
» — Code Differential, OmniSTAR VBS +— RTK Fixed, Variable Fixed, OmniSTAR HP, OmniSTAR
XP

You can apply a unique color to each solution type using Status tab of the Setup dialog box.
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Use tool buttons in the lower part of the screen to customize the graphic view. g
(@)

Button Description g
M

&) Zooms the plot inwards. ""
- <
o

= Zooms the plot outwards. 3
— 0,
. 3

x Clears all points from the screen. o

&, Fits all points in the plot.

Moves the center of the plot to the average of all points.

[+

~ It is possible to click and drag the plot to change the center point. On a computer version, you can
= use the mouse wheel to change the scale.
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Position in Time

The Position in Time tab displays the receiver position in real time.

Three graphs in the screen represent 3D position in time: Latitude, Longitude, and Altitude. Each graph shows both
absolute and relative values and the time scale. The time scale varies from 1 to 5 hours.

You can apply a unique color to each solution type using Status tab of the Setup dialog box.
Use tool buttons in the lower part of the screen to customize the graphic view.
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Button Description

= Zooms the plot inwards.

= Zooms the plot outwards.

x Clears all points from the screen.

Status P/N: 7010-0908




Logging
The Logging tab allows logging real-time measurements into files and saving them in the computer.

* File Path: full path to the file in which data is logged. Use the [...| button to navigate.

* Raw Measurement: Elevation Mask, Period: defines the minimum angle for satellites from which the receiver
outputs raw data to a stream and sets the recording interval in seconds (for this, clear Default).

* Statistics: shows file logging statistics in progress after logging has begun.

* Start Logging: click the button to start Logging the file. After clicking, the button changes to Stop Logging.

* Logging Messages: opens the Logging Messages screen to view/edit a list of messages being logged into the
file and logging parameters.

* Site Parameters: opens the Site Configuration dialog box to apply antenna parameters for data logging
purposes at the site.

Sui8eueyy 1an1909Y

If one or more message(s) in the list has a period less than the position or raw measurements

@gg update rate of the receiver, an error message displays. To log a file with such a period you
have to change the update rates in the property sheet Tracking Options, Msint tab.

Logging Messages
The Logging Messages screen enables you to edit a list of messages being logged into the file and also parameters
of a selected message. You can add or remove messages or modify their scheduling parameters using the pop-up menu
options. The receiver keeps the customized message set in the NVRAM for further usage.

* Add new messages: opens the Receiver Message List dialog to add new messages to the message list.

* Edit message: opens the Receiver Message dialog to edit the highlighted message.

* Delete messages: deletes the highlighted messages.

Status P/N: 7010-0908



* Restore Defaults: restores the list of output messages to the factory defaults.
* Refresh: renews the list output messages with the last made changes.

Site Configuration
The Site Configuration dialog allows editing site and antenna parameters for data logging purposes.

* Site Name: the name of the jobsite.
* Description: additional information about the site.
¢ Antenna Parameters:

— Antenna Type: the type of antenna.

— Antenna Height, m: the height of the antenna in meters measured from the survey marker to the measuring
mark on the antenna (either ARP or SHMM).

— Slant: if selected, indicates that the height of the antenna was measured at a slant (to the slant height
measurement mark - SHMM). When not selected, indicates a vertical measurement (to the antenna
reference point - ARP).

— Dynamics: select either Static or Dynamic to set the status of the antenna; either fixed or moving,
respectively.

— Send parameters automatically: send site and antenna parameters to the receiver each time a log file is
created.

A
M
0
o,
<
o
=
<
o))
3
Q
£y
=
09

Status P/N: 7010-0908




File Explorer

N\
The File Explorer icon \1{ g opens the File Explorer screen, which contains four tabs:

* Files - to manage files.

* Logs - to log current files.

e MINTER - to set logging parameters for MINTER operation.

* AFRM - to enable Automatic File Rotation Mode. Unavailable for the HiPer II and HiPer V.

* UMS Files — displays and manages raw data files stored on the USB Mass Storage Device (UMS). This tab is
available for the Net-G3A receiver only.

* UMS Cfg — configures a connected UMS device. This tab is available for the Net-G3A receiver only.
Files

The Files tab displays the list of raw data files stored in the receiver memory. Along with the file names, this list contains
the file sizes in bytes, and date and time the files were recorded.

The Files tab allows managing files. The pop-up menu displays the options:

* Refresh: reloads the list of files.
* Delete: deletes the selected log files. A confirmation message displays.

* Download: begins downloading selected log files to the computer. A download path must be specified.
Clicking OK starts downloading process.

* Upload: begins uploading files from the computer to the receiver. A full path to the file on the computer must
be specified before beginning the upload process.
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* Copy to UMS: copies the selected files from the receiver to a connected UMS device. This setting is available
for the Net-G3A receiver only.

* Initialize File System: initializes the file system. Initializing the file system of a connected receiver erases all
of the receiver’s data files. A warning message appears to confirm the operation.

* File System Info: displays information on the file system and physical memory of the internal memory card in
the receiver.

* Mode of Operation: selects operational mode for File Explorer:
— Normal - this mode allows all operations on the files (deleting, downloading and uploading).
— Deleted Files Recovery - this mode allows retrieving deleted files from the internal memory of the receiver.
To recover a deleted file:
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* Open this mode to view all deleted files.
* Download the desired file to a selected folder on the controller.
* Select Normal mode and upload the deleted file from the controller to the receiver.

= Deleted log files can be retrieved from the receiver internal memory only if the receiver has
- not been initialized.

Information about File System

The File System Info dialog displays information on the file system and physical memory of the internal memory card
in the receiver.

Files (HiPer Il and HiPer V only)

The Files tab displays the list of raw data files stored in a removable memory card.
Along with the file names, this list contains the file sizes in bytes, and date and time the files were recorded.
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You can also use this tab to manage files. The pop-up menu displays the following managing options:

* Refresh: reloads the list of files.
* Delete: deletes the selected log files. A confirmation message displays.

* Download: begins downloading selected log files to the computer. A download path must be specified. Clicking
OK starts downloading process.

* Initialize File System: initializes the file system. Initializing the file system of a connected receiver erases all
of the receiver’s data files. A warning message appears to confirm the operation.

. Frile System Info: displays information on the file system and physical memory of the internal memory card in
the receiver.
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Logs

The Logs tab allows recording log files.

* Log File: selects current file - /cur/file/a or /cur/file/b.

* File Name: specifies the name of the file, which will be created.

* Elevation Mask, deg: sets the elevation masks for TPS messages output to the file.
* Periods: specifies the rate at which the receiver records the log files.

— Clicking Start begins recording data into the file with the recording interval of 1 second by default. Uncheck
the Default box to change the interval.

* Logging Messages: displays the list of messages outputting into the current log files.
* Site Parameters: sets the jobsite and antenna parameters.
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If one or more message(s) in the list has a period less than the position or raw measurements update
@@S rate of the receiver, an error message displays. To log a file with such a period you have to change
the update rates in the property sheet Tracking Options, Msint tab.

Logs (HiPer Il and HiPer V only)

The Logs tab allows recording log files.

Sui8eueyy 1an1909Y

* File Name: specifies the name of the file, which will be created.
* Elevation Mask, deg: sets the elevation masks for TPS messages output to the file.
* Period,s: specifies the rate at which the receiver records the log files.

* C(licking Start begins recording data into the file with the recording interval of 1 second by default. Uncheck the
Default box to change the interval.

Logging Messages: displays the list of messages outputting into the current log files.
Site Parameters: sets the jobsite and antenna parameters.

If one or more message(s) in the list has a period less than the position or raw measurements update
@@ rate of the receiver, an error message displays. To log a file with such a period you have to change
the update rates in the property sheet Tracking Options, Msint tab.
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MINTER

The MINTER tab sets the receiver parameters that correspond to MINTER operation and data logging.

* Prefix: determines the file name prefix used as the beginning part of the name of the new file the receiver
creates when the MINTER FN button is pressed to start data recording. The prefix can include up to 20
characters; the default is “log”.

* Period: specifies the interval to use for logging data after pressing the MINTER FN key. This parameter also
applies to AFRM mode. It can be set to the values from 0 to 86400 seconds; the default is 1 second.

* Log File Controllable via AFRM and MINTER: select either one of the concurrent files or both to allow controlling
them by MINTER and through the automatic file rotation algorithm.

* Advanced: opens the MINTER dialog.

Advanced Settings

The MINTER dialog allows editing advanced settings
* FN Key Mode: Programs the receiver's reaction after pressing the FN key. For the HiPer SR+, this setting is called
Function/Power Key Mode.

— Led blink mode switch: pressing and holding down the FN key for less than a second, you switch the
receiver between standard and extended information modes. Refer to the receiver's Operator's Manual for
details about these modes. This is default value.

— Occupation mode switch: pressing and holding down the FN key for less than a second, switches the
receiver between static and kinematic survey modes when recording a file. The receiver outputs an
appropriate freeform event to the current log file every time you switch the survey mode.

 [Initial Data Collection Dynamic Mode: Specifies the initial dynamic mode for all of the new files opened through-
MINTER when FN Key Mode is set to the Occupation mode switch mode. Default value: Static.

* Data Recording Auto-start: Programs the receiver's behavior in the event of a power failure. Default value is Off.
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— Off: The receiver does not resume data logging on start-up.

— On: Should a power failure occur when the receiver is logging data, the receiver automatically opens a new
file and resumes data recording when power has been returned. From a functional point of view, this is
equivalent to pushing the FN button once the receiver is powered on again.

— Always: This case is similar to the previous one except that the autostart mechanism launches at the
receiver start time irrespective of whether the power failure occurred while data recording or not.

— Always Append to the File: Specify the name of an existing file to append new data to. The file name can be
up to 20 characters.

MINTER (HiPer Il and HiPer V only)
The MINTER tab sets the receiver parameters that correspond to MINTER operation and data logging.
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* Prefix: determines the file name prefix used as the beginning part of the name of the new file the receiver
creates when the power button is pressed to start data recording. The prefix can include up to 20 characters;
the default is 10g.

* Period: specifies the interval to use for logging data after pressing the power button.It can be set to the values
from 0 to 86400 seconds; the default is 1 second.

AFRM

The AFRM tab enables Automatic File Rotation Mode (AFRM). This option is unavailable for HiPer II and HiPer V
receivers. In this mode the receiver closes the current log file and open a new one according to a schedule defined by
the parameters File Rotation Period and File Rotation Phase:

¢ Enable AFRM: when selected, activates AFRM.

* Automatically Remove Old Files: when selected, the receiver removes log files with the earliest creation
time/date if no free memory is available for recording data.
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* File Rotation Period: sets the time duration of each log-file created in AFRM.

* File Rotation Phase: sets the phase (constant time shift) of creating multiple log-files in AFRM.

* File Rotation Counter: sets how many log files must be created in AFRM before AFRM mode turns off.
* File Rotation Running Counter: reports the number of files remaining before AFRM mode turns off.

* Force File Rotation: forces the receiver to execute file rotation immediately. AFRM must be enabled.

UMS Files

The UMS Files tab displays the list of raw data files stored on the UMS device.
Along with the file names, this list contains the file sizes in bytes, and date and time the files were stored.
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The UMS Files tab is also used to manage the files. The pop-up menu displays the following settings:

* Refresh: reloads the list of files.
* Delete: deletes the selected files. A confirmation message displays.

* UMS Device Info: displays information about the UMS device connected to the receiver, includingits name,
firmware version, file system details, and more.

UMS Device Information

The UMS Device Info dialog box displays information about the UMS device connected to the receiver, including its
name, firmware version, file system details, and more.

The UMS Cfg tab allows you to activate the connected UMS device and manage how you want to copy files.

* Activate the UMS Device: makes the connected UMS device ready (active) for copying the raw data files.

* Overwrite Existing Files: overwrites any previous raw data files on the UMS device with the new files of the same
names when copying them from the receiver’s memory to the UMS device.
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* Automatically Copy the Current File: automatically copies the current file on the UMS device after closing the file.

* Automatically Copy All Files: automatically copies all files, including the current file, immediately after the active
UMS device is connected to the turned-on receiver or the receiver is power cycled with the UMS device being
connected.

Modem Driver

The Modem Driver icon 'LL opens the Modems dialog that displays internal modems connected to the receiver.
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If no modem has already been detected (there is no information about a modem in the permanent NVRAM), once you
open the dialog, modem detection process starts. When TRU finds a modem, the name displays in the dialog. If itis a
cell modem or detected radio modem has a cell module, TRU prompts you to install a driver for this modem.

Topcon applications may need a driver to use the internal cell modem installed in the receiver. The
- ,@ driver represents a set of scripts, which the GNSS firmware executes to connect to the modem, to
- make a call, etc. Some applications can use cell modems directly and do not need a driver, but it is
recommended to install a driver for all the internal modems with the cell module.

/@ If the internal modem is replaced, or if the baud rate of the internal radio or cell modem has been
< ;
= changed, you need to update the driver.
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The pop-up menu in the Modems dialog includes the following options.

* Scan for hardware changes - This option can be used to detect whether the radio or cell modems (or their baud
rates) have been changed. If TRU detects any changes, it updates information about the modems in the
permanent NVRAM of the receiver, and offers to the user to update the driver.

. erperties - Displays the Modem Properties window where you can view information about the modems and
rivers.

* Update Driver - Displays a Wizard, which helps the user to update the cell modem Driver.

Modem Properties: Modem

The Modem screen displays the physical port of the receiver, which the modem connect to, names of primary (usually
radio) modem, secondary (usually cell) modem, and baud rate of each module.

Clicking the Detect Modems button initiates modem detection process. TRU searches for modems and update
information about them in the permanent NVRAM.

Modem Properties: Driver

The Driver screen displays information about the currently installed driver, and allows updating or uninstalling the
driver.

* Driver Name - an internal name of the driver

¢ Driver Version - the version of the driver

* Driver Description - a user friendly name of the driver

* Driver Details shows a list of files which the driver consists of.

e Update Driver shows a Wizard, which helps the user to update the driver or install a new one.

* Uninstall erases the driver, its internal variables and the information about the modem from permanent NVRAM
of the receiver.
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Updating Modem Driver: Selecting Driver Source

This screen allows you to select a driver source. When it is selected, TRU displays the file version.

The driver source is an XML file, which consists of one or more drivers.

///»@ The file version is required to support service. The version increases when any changes to the file are
made and it is not related to the version of the driver for your specific modem(s). The driver version
is displayed on the second screen.

Every TRU installation includes a default driver library for all the officially supported equipment as of
the release date of TRU. If you have a newer library, you may use it instead of the default one.
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Updating Modem Driver: Selecting Driver

This screen allows you to select a driver from a list of all the drivers found in the file specified on the first screen.

The Wizard does not actually detect modems. It uses information about the modems previously
//,@ stored in the permanent NVRAM of the receiver. If your modem(s) have not been detected vyet, it is
- recommended to detect them using the Scan for hardware changes menu item in the Modems dialog,
or using the Detect Modems button of the Modem Properties property sheet.

If there is only one driver, which is compatible with the hardware, TRU highlights it. Otherwise you
must select a driver manually.
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Updating Modem Driver: Variables

This screen displays and allows editing variables of the driver.

Default variable values are recommended for most of the users.

///»@ Do not modify variable values unless it is really needed, you know what to do or received instructions
from Topcon dealer or Topcon support. If the variables have not been initialized properly, the driver
will not function.

There are two types of variables. If there is a physical name, this variable is a real variable stored in
the NVRAM, and it can be read or modified by applications. If there is no a physical name, this
variable is a constant and its value cannot be read or modified after the driver has been installed.

Updating Modem Driver: Installing Driver

When you see the fourth screen, the Wizard starts to install the driver. On this step the Wizard uninstalls old driver,
compiles and uploads files of the driver to the receiver.

GRS Tools

When running on GRS-1 platform, the Device drop-down menu of the Main Window contains the GRS Tools item.
The GRS Tools item opens the GRS Tools screen that can manage the receiver, modem and compass.

* The Receiver tab controls power parameters of the internal GNSS receiver.
* The Modem tab controls power parameters of the internal modem.

* The Compass tab displays the current North/South direction and the angle to North, displays the tilt of the unit,
and calibrates the compass.
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Receiver

The Receiver tab controls power parameters of the internal GNSS receiver.

* Current Power State — shows the current power state of the internal GPS board, either ON or OFF.
* Power ON/OFF — turns on/off the GPS receiver power.

* Reset The Receiver — performs a hardware reset of the internal GNSS receiver. From a functional point of
view, the hardware reset is equivalent to turning the power off and then back on.

e Clear NVRAM - clears the receiver's NVRAM. All receiver parameters are set to their default values. Almanacs,
ephemerides, etc., are erased. This operation does not delete any raw data files stored in the receiver's memory.

* Turn power ON when connecting to the internal receiver — check mark this box for TRU to turn ON the
internal GPS board, when connecting to it.

* Turn power OFF when disconnecting from the internal receiver — check mark this box for TRU to turn
OFF the internal GPS board, when disconnecting from it.

* Turn power OFF on exit — check mark this box for TRU to always turn OFF the internal GPS receiver power
on exit.

Modem

The Modem tab controls power parameters of the internal modem.

* Model — shows the model type of the modem.
* Current Power State — shows the current power state of the internal modem, either ON or OFF.
* Power ON/OFF — turns on/off the modem power.

* Turn power ON when connecting to the internal modem — check mark this box for TRU to turn ON the
internal modem, when connecting to it.
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* Turn power OFF when disconnecting from the internal modem — check mark this box for TRU to turn
OFF the internal modem, when disconnecting from it.

* Turn power OFF on exit — check mark this box for TRU to always turn OFF the modem power on exit.

Compass

The Compass tab displays the current direction, tilt of the unit. This tab also calibrates the compass.

¢ Pointer — North (red portion of pointer) and South (black portion of pointer) directions.
* Compass — the angle (azimuth) from North, in degrees.
* Tilt — the roll and pitch, from level, in degrees and minutes.
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The compass is very sensitive to the tilt of controller. To measure precise azimuth values, make sure
<//\/>@ that both vertical and horizontal tilt values equal zero, and the tilt pointer is located within the
crosshair.

* Calibrate — The compass may need to be calibrated if you notice that its precision is no longer accurate. The
calibration procedure depends upon the compass hardware.

The GRS -1 controller keeps the compass calibration data.

///gs The Calibration procedure excludes magnetic influence of the surroundings in the place where the
compass is used. The factory calibration is performed with a separate utility.
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Backpack Tools

When running on Tesla RTK platform, the Device drop-down menu of the Main Window contains the Backpack
Tools item.

The Backpack Tools item opens a screen to control power parameters of the Topcon GNSS receiver in the backpack

attached to the controller.

Current Power State — shows the current power state of the internal GPS board, either ON or OFF.

Power ON/OFF — turns on/off the GPS receiver power.

Reset The Receiver — performs a hardware reset of the internal GNSS receiver. From a functional point of
view, the hardware reset is equivalent to turning the power off and then back on.

Turn power ON when connecting to the internal receiver — check mark this box for TRU to turn ON the
internal GPS board, when connecting to it.

Turn power OFF when disconnecting from the internal receiver — check mark this box for TRU to turn
OFF the internal GPS board, when disconnecting from it.

Turn power OFF on exit — check mark this box for TRU to always turn OFF the internal GPS receiver power
on exit.
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Modem Managing

Modem Managing mode is intended for configuring Topcon and 3rd party modems.

[

In Modem Managing mode, you see the Settings icon *i“‘"‘ in the tools area.
1&*

/@ Initially, the Tools area is inactive. To make the tools area active, first establish a port connection on the PC
using the Connect option from the Device menu. See “Connection” on page 8.

N

See “Appendix B” “Digital UHF Radio Firmware v2.0 Upgrade Process” on page 129 for information on
= upgrading your Digital UHF radio firmware.

When in Modem Managing mode, TRU tries to detect a modem at the time of connection. If there is no modem, or if it doesn't
respond, a connection cannot be established.
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The Settings icon opens a dialog that displays the modem's settings, and allows changing the settings and invoking
modem functions (Figure 15).

Topeen - Digital UHF I

General | Settings | Functions

Manufacturer: Topcon

Modem Model:  Digital UHF II

Product idertification information:

Digital UHF |l Radic Modem, Topcon Positioning Systems -
Product 1D =

SiN=

Hardware = Rev.

Software = Version: 1

BootLoader = Version: 2
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Figure 15: Modem Settings Dialog Box

It is important to pay attention to the Hardware listing in the Modem Settings dialog box to fully
//ZS understand the hardware installed on your receiver. For example, the Digital UHF I radio is reported
- as Aw-401Tc or Aw-401Hi, while the Digital UHF II radio is reported as DUHF II. You are required to
specify radio hardware and firmware information, along with details on the problem, when contacting
the Topcon support or service group for troubleshooting.

P/N: 7010-0908




General Information

The General tab shows the modem model, and the product identification information.

¢ C(licking the Terminal icon opens the Terminal dialog.

* When you click the Cell Info putton, TRU detects the cell modem, and, if it finds the modem, connects to it and
opens the Settings property sheet for the cell modem.

<//\,§ If currently connected modem cannot have a cell module, the Cell Info button is disabled.
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Modem Settings

The Settings tab shows a list of parameters specific for a connected modem. The settings list may vary depending on
the modem model and possibly the firmware version.

Four icons on this tab serve the following purposes:

. t_+| renews the list.

. EI imports settings from a file.

saves settings in a file.

|
J i writes new setting into the modem.
The settings can be read-only (marked by the icon) or changeable (marked by the L=l icon).
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Modem Functions

The Functions tab allows you to invoke a modem's functions.

¢ Function — shows a list of available functions.
* Execute - starts executing the selected function.

* Input Parameters — shows a list of incoming parameters for the selected function. These parameters should be
initialized properly before the function is executed.

¢ Qutput Parameters — shows a list of values returned by the function.

<
0
Q.
¢}
3
<
S
2
o
0,
=
09

P/N: 7010-0908




Modem Types

The following sections describe specific parameters and functions for each modem. See “"Modem Managing” on page 89 for
general information and features commonly available for all modem types.

FH915 Plus
Settings

* General parameters:

— Baud Rate, bps — specifies the baud rate of the modem's serial port connected internally with the receiver's serial
port. It can be 19200, 38400 (default), or 57600.

— Flow Control — enables/disables the RTS line of the modem's serial port connected internally with the receiver's
serial port. It can be either RTS/CTS (default) or None.

* Radio parameters are accessible only if GSM mode is Off:
— Protocol — sets an operation protocol. It can be either FH915 (default) or FH915 Ext.

— Location — adjusts the frequency range and RF power level depending on the country. It can be USA/Canada
(default), Australia or New Zealand.

— Operation Mode - specifies the mode in which the radio modem will be functioning. It can be Receiver (default),
Transmitter, Repeater or None.

— Power, mW — sets the transmission power for the base radio modem. It can be either 250 or 1000 mW (default).
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— Link Rate, bps — specifies the rate at which data is transmitted over the RF link in FH915 protocol. It can be
9600 (default), 12000, 17000, 24000, or 51000 bauds.

— Ext Link Rate, bps — specifies the rate at which data is transmitted over the RF link in FH915 Ext. protocol.
It can be 3600, 4800, 6600, 9600 (default), 19200 bauds.

— Channel - this feature allows up to ten simultaneously transmitting radio modems, without interference, at
the jobsite (1- default).

¢ GSM parameters:

— Mode - specifies the GSM modem operation mode. It can be Off (default), Slave, Master, or Direct.

— PIN — specifies the PIN code for access to the GSM modem. It can be a 4-digit number.

— Dial — specifies the phone number that the GSM modem, in Master Cell mode, dials in to the remote Slave
modem. It can be a number of 0..14 digits.

— Send Time, s — specifies a time interval from 0 to 255 in seconds, is used to ensure reliable communication
between the pair of modems (Master - Slave) and avoid unnecessary modem reinitialization. The
transmitting modem sends the service word to the receiving modem in every “sndtime” seconds. Note that
the service word will not affect the differential corrections (RTCM or CMR messages) in any way. If the
parameter is set to zero, the service word is not used in data transmission.

* Advanced parameters:

— H/W Version — queries the hardware version of the board.

— Net ID - sets network ID. A radio link can only be established between modems having the same Net ID. It
can be the number in the range from 0 (default) to 255.

— Rep Net ID — sets a new Rep Net ID parameter for Repeater type. A modem with Repeater type set carries
out retransmission with other Rep Net ID that is different from receiving Net ID. In this mode, it is possible
to set different Net IDs for received and retransmitted signals. It can be the number in the range from 0
(default) to 255.
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— Hot Lock, s — sets time to keep synchronization after signal drop. It can be 5, 10, 20, 30 (default), or 40

seconds.
— Save Power — enables/disables (default) Power Saving mode. The transmitter and receiver must be set to

the same mode.

Topcon UHF460
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Settings

* General parameters:

— BaudRate — select a baud rate for the modem'’s serial port. The baud rate is adjustable. This is the flow rate
on the serial port connecting the modem to the GPS board. It can be 19200 or 38400 (default) rate with this
radio.

e Radio parameters:

— Protocol — sets the protocol for data transmission. Select between TPS and PDL. Select TPS if all of the
radio-modems at the jobsite are manufactured by Topcon Positioning Systems. Select PDL if using PDL
radio-modem(s) together with TPS radio-modem(s) at the jobsite.

— Type — select a modulation scheme that will be used by the base radio-modem. It can be either OFF or 4-
Level-FSK (Frequency Shift Keying) or GMSK (Gaussian Minimum Shift Keying). Refer to "Appendix A” on
page 123 for link, rate, channel spacing, protocol, and modulation information.

— RadioLink — select the rate at which data is transmitted over the RF link. The UHF radio-modem supports
4800, 9600 (default), and 19200 baud. Note that this setting affects the Modulation Type control and vice
versa. Must be the same for the base and rover.

— LinkProtocol — select the appropriate link protocol among the following available: FastAsn, TimeOut, and

CharOut.
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— TimeOut — enter an integer value between 1 (corresponds to 10 ms) and 50 (corresponds to 500 ms). Once
the timeout between incoming data exceeds the specified value, the modem begins data transmission.

— ControlChar — enter a decimal value (usually a control character). Once the specified character is found in
the incoming data stream, the modem begins data transmission.

— Scrambler — If set to ON, provides more robust data communications over the areas with possible
interference. Must be the same for the base and rover.

— FEC — For a maximum data communication reliability, set the Forward Error Correction to ON (default). In
this case, the rover radio-modem has the capability to check and correct transmission errors (if any) in an
incoming data stream.

— RxChannel — select the operating frequency that will be used by the rover radio-modem to receive
differential data. Must be the same for the base and rover.

— TxChannel — select the operating frequency that will be used by the base radio-modem to transmit
differential data.

— Power — select the transmission power for the base radio from 10, 20, 50, 100, 250, 500 mW, 1 or 2 W.

— FcsMode — select between OFF (default), RxSlave, TxMaster

— FcsNoiseDb — select between 70, 85, 100 dBm, or Custom to specify a threshold value for the noise level for
the current operating frequency in Free Channel Scan mode.

* GSM parameters for the GSM module integrated into a receiver:

— GsmMode- set the mode control to OFF (default), Slave, Master, or Direct.

— GsmPin- enter a Personal Identification Number (PIN) if required.

— GsmDial- on the rover side, enter the phone number of the base GSM modem.

— GsmSndTime— enter a period of time in seconds with which the base/rover GSM modem sends a service
word to the rover/base GSM modem. This parameter is used to maintain reliable communication between
the pair of modems and avoid unnecessary modem reinitialization.
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Digital UHF
Settings

* General Digital UHF! parameters:
— Mode — selects Radio or Cell to use for communication (the UHF or GSM/CDMA band, respectively).
— Baud rate, bps — selects a baud rate for the modem’s serial port.
— Flow Control — enables hardware flow control.
* Radio parameters:
— Frequency, MHz — assigns an operating channel to the radio modem. Select the desired frequency from the
list.
— Protocol — sets the protocol for data receiving/transmitting.
— Modulation — selects a modulation type for the base radio modem.
— Link rate, baud — data transfer speed between the base and rover. This parameter depends on the
modulation and the space value.
— Network has Repeater — enables retransmission in the wireless cluster only for Simplex Transmitter protocol.
— Power, mW — sets the transmission power for the base radio.
— Scrambler — when enabled, provides more robust data communication over high interference areas.
— FEC — (Forward Error Correction) Enable to maximize data communication. The rover radio modem has the
capability to check and correct transmission errors (if any) in an incoming data stream.
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1. Digital UHF I modem with radio firmware version 1.6 or earlier.

Digital UHF P/N: 7010-0908 97



Functions
* BootConfiguration: This command is intended to reboot the unit using selected user settings. Two options are
available, to use the default user settings defined by dealer or to use the settings defined by the end-user.

* UploadCCXFile: Intended to upload the factory and dealer configurations along with the user defined radio
settings. After uploading the CCX file, the uploaded file takes into effect after the configuration reboot (see the

previous function).

Digital UHF II
Settings

* General parameters:
— Mode - selects Radio or Cell to use for communication (the UHF or GSM/CDMA band, respectively).
— Baud rate, baud — selects a baud rate for the modem'’s serial port.
— Flow Control — enables hardware flow control.

* Radio parameters:

— Frequency, MHz — assigns an operating channel to the radio modem. Select the desired frequency from the
list.

— Protocol — sets the protocol for data receiving/transmitting.

— Modulation — selects a modulation type for the base radio modem.

— Spacing, kHz — selects the channel spacing.

— Link rate, baud — data transfer speed between the base and rover. This parameter depends on the
modulation and the space value. Refer to "Appendix A” on page 123 for channel spacing, protocol and
modulation information.

Digital UHF II P/N: 7010-0908
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— Power, mW — sets the transmission power for the base radio.
— Scrambler — when enabled, provides more robust data communication over high interference areas.
— FEC — (Forward Error Correction) Enable to maximize data communication. The rover radio modem has the
capability to check and correct transmission errors (if any) in an incoming data stream.
— Callsign
e Satel parameters:
— FCS Net ID, hex: Configures network ID.
— Address Receiving: Configures address receiving.
— Address Transmission: Configures address transmission.
— RX Address, hex: Configures the receiving primary address.
— TX Address, hex: Configures the transmission primary address.
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Functions

The following functions are available for executing in this modem:
* BootConfiguration: This command is intended to reboot the unit using selected user settings. Two options are
available, to use the default user settings defined by dealer or to use the settings defined by the end-user.
* FactoryReset: Resets all the parameters to their default values.
* UploadFile: Intended to upload Country Configuration File (CCF) or Dealer Configuration File (DCF).

MHz, and has been delivered to you in a default factory configuration. The default factory
configuration to support operation in 400-470 MHz is achieved through CCF configuration file. You are

@ Be aware that the Digital UHF II modem supports a wide UHF frequency range of between 400-470
not supposed to update or modify existing CCF file until instructed by Topcon professional.
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Before operating a receiver equipped with a Digital UHF II radio, you must upload the frequencies needed for radio
communication in your specific region. UHF frequencies in your region may be licensed or unlicensed, but are always
subject to some level of restriction within the overall 400-470 MHz range. Your dealer should load the DCF before
giving you the receiver integrated Digital UHF II radio. If your receiver is not loaded with UHF frequencies specific to
your region, contact your local dealer and request that he supplies you with a DCF containing licensed UHF
frequencies and channel spacings.
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Once you receive the DCF from the dealer (refer to “Appendix C” on page 133), you must have the latest release
version of TRU and do the following:

1. Install TRU on your mobile device or computer.

2. Copy the DCF provided by your dealer and paste it into the hard drive of your mobile device or computer.

3. Run TRU.

4. Connect to the internal radio modem of the receiver, using the Modem Managing mode of TRU.

5. Click on the Functions tab, and select UploadFile in the Function control.

6. In the File property of Input Parameters, select the DCF saved on a local drive and select DCF as the type of
file.

7. Click Execute to load the radio frequencies into the radio.

8. Click Execute once more on Settings to ensure that all frequencies are correctly loaded and appear available for

use.

procedure may result in non-operation of the Digital UHF II radio or breach of local regulatory laws
that govern radio communications. If you have further questions or concerns, contact your local
Topcon representative.

v A valid DCF configuration is mandatory before using the product. Failure to understand and apply this
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Satel® UHF Modem 2
o]
. Q
Settings g
The UHF Satel radio modem offers a transmitter/receiver/repeater functionality with a maximum 1W power output for -
data transmission. The frequency range of the modem depends on the country in which the receiver is used. %
0]
The default settings for radio configuration are sufficient for most jobsites. Changing these settings 2

= can affect the operation of the radio modem and communication between receivers.

The settings can be read-only (marked by the icon) or changeable (marked by the icon). Clicking on the
corresponding line in the Value column of any editable parameter opens a field to enter or select from the drop-down

list a needed value.

* General parameters:
— Model — the product model identification text.
— Hardware Version — the hardware revision of the modem.
— Firmware Version — the firmware version of the modem.
— Product Code — specifies the product code.
— Serial Number — specifies the serial number unique for the modem.
— Baud Rate, baud - specifies the baud rate of the modem's serial port connected internally with the receiver's
serial port, by default with hardware flow control.
¢ Radio parameters:
— Frequency, MHz - the operating frequency used for data transmission and reception.
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— Protocol - selects a protocol and a modulation type.
— Spacing, kHz - displays the channel spacing. This is determined by the hardware.

— Satel FEC - Forward Error Correction technique to maximize data communication. The rover radio modem
has the capability to check and correct transmission errors (if any) in an incoming data stream.

— Power, mW - sets the appropriate level of output power.

— Repeater - Enables/Disables repeater function.

— TX Delay, ms - Specifies TX delay.

— TX Addressing - Specifies TX address mode.

— TX1 Address, hex — Specifies primary transmit address.

— TX2 Address, hex — Specifies secondary transmit address.

— RX Addressing — Specifies RX address mode.

— RX1 Address, hex — Specifies primary receive address.

— RX2 Address, hex — Specifies secondary receive address. FCS parameters:

— FCS Mode - Allows enabling Free Channel Scan mode.
In free channel scan mode, the Base radio modem regularly scans the current operating frequency to
determine the degree of a radio noise (interference). If the level of noise on the current operating frequency
is greater than the threshold specified in the Signal Threshold field, the transmitter stops broadcasting and
switch to the next frequency.

— Net ID- sets Free Channel Scan Net ID.

Satel® UHF Modem
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Occasionally, the receivers may encounter interference if a jobsite has more than one set of
receivers. In this case, enter a different net ID for each set of receivers.

To properly communicate, the Base and Rover radios require the same settings for Current
Frequency, FCS and Net ID.
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Functions

¢ AddChannel: This command is intended to add an operating frequency from a list defined by the dealer to the
list defined by the user.

* DeleteAllChannel: Intended to delete all operating frequencies from the list defined by the user.
* FactoryReset: Resets all the parameters to their default values.
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Q2
Settings

* General parameters:

— Baud rate, baud — selects a baud rate for the modem’s serial port connected internally with the receiver's
serial port.

* Radio parameters:

— Band - Indicates the frequency band and spacing.

— RX Frequency, MHz - the operating frequency used for data reception.

— TX Frequency, MHz - the operating frequency used for data transmission.

— Protocol - current protocol.

— Modulation - current modulation type.

— Link rate, baud — specifies the rate at which data is transmitted over the RF link. This parameter depends on
the modulation and the space value. Refer to “"Appendix A” on page 123 for channel spacing, protocol and
modulation information.

— Scrambling - indicates use of the scrambler.
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— FEC - (Forward Error Correction) Enable to maximize data communication. The rover radio modem has the
capability to check and correct transmission errors (if any) in an incoming data stream.

— CRC Checking - indicates the checksum use (CRC="Cyclic Redundancy Check") when receiving a package. If
the checksum is wrong (the package was received with errors), the data is not applied.
— Power, mW - the transmission power for the base radio.
— FCS - the operation mode in the Free Channel Scan mode.
e Satel parameters (applied to Satel-compatible protocols):
— Satel Mode - the modem operation mode.
— Satel FEC - Forward Error Correction.
— Satel CRC Checking - indicates the checksum use.
— Satel TX Addressing - Configures address transmission.
— Satel TX Address, hex - Configures the transmission primary address
— Satel RX Addressing - Configures address receiving.
— Satel RX Address, hex - Configures the receiving primary address.
¢ GSM parameters
— Mode - specifies the GSM modem operation mode.
— PIN - specifies the PIN code for access to the GSM modem. It can be a 4-digit number.
— Dial - specifies the phone number that the GSM modem, in Master Cell mode, dials in to the remote Slave
modem. It can be a number of 0..14 digits.
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— Send Time, s - specifies a time interval from 0 to 255 in seconds, is used to ensure reliable communication 2
between the pair of modems (Master - Slave) and avoid unnecessary modem reinitialization. The 0
transmitting modem sends the service word to the receiving modem in every “"Send Time"” seconds.. %

3
Note that the service word will not affect the differential corrections (RTCM or CMR messages) in any —
= way. If the parameter is set to zero, the service word is not used in data transmission. %
0]
0
Functions

¢ AddChannel: This command is intended to add an operating frequency from a list defined to the user’s list.
* DelChannel: Intended to delete an operating frequency from the list defined by the user.

* FactoryReset: Resets all the parameters to their default values.

¢ GetChannelFCS: Shows if a channel can be used in the FCS mode.

¢ SetChannelFCS: Enables/Disables use of a channel in the FCS mode.

¢ SetBand: Changes the current band (and the step).

@@ Supported bands depend on the hardware.
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GSM/HSPA Modems

This section describes the settings and features for the following GSM modems:

* Motorola H24 HSPA

¢ Motorola G24 GSM

* Cinterion HC25/HC28/HC2831
¢ Wavecom Q24

¢ Wavecom Q26 GSM

Settings

* Manufacturer — the manufacturer identification text.

* Model — the product model identification text.

e Firmware Version — the product firmware version.

e IMEI - the International Mobile Equipment Identity (IMEI) of the module.

¢ IMSI — the International Mobile Subscriber Identity (IMSI).

* Authentication — the string indicating whether or not network authentication is required.
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SIM PIN authentication

READY PIN has already been entered. No further entry needed.
SIM PIN The modem is waiting for SIM PIN1.
SIM PUK The modem is waiting for SIM PUK1 if PIN1 was disabled after three failed attempts to enter PIN1.

1. Used in the GRS-1 GNSS receiver.
GSM/HSPA Modems P/N: 7010-0908 106



SIM PIN2

The modem is waiting for PIN2.

SIM PUK2

The modem is waiting for PUK2 to unblock a disabled PIN2.

Phone security locks set by client or factory

PH-SIM PIN | The modem is waiting for phone-to-SIM card password if “PS” lock is active and the client inserts other
SIM card than the one used for the lock. ("PS" lock is also referred to as phone or antitheft lock).

PH-FSIM PIN | The modem is waiting for phone-to-very-first-SIM card. Necessary when “PF” lock was set. When
powered up the first time, The modem locks itself to the first SIM card put into the card holder. As a
result, operation of the mobile is restricted to this one SIM card (unless the PH-FSIM PUK is used as
described below).

PH-FSIM PUK | The modem is waiting for phone-to-very-first-SIM card unblocking password to be given. Necessary
when “PF” lock is active and other than first SIM card is inserted.

PH-NET PIN' [ The modem is waiting for network personalization password.

PH-NET PUK [ The modem is waiting for network personalization unblocking password.

PH-NETSUB | The modem is waiting for network subset personalization password.

PIN

PH-NETSUB | The modem is waiting for network subset unblocking password.

PUK

PH-SP PIN The modem is waiting for service provider personalization password.

PH-SP PUK | The modem is waiting for service provider personalization unblocking password.

PH-CORP PIN | The modem is waiting for corporate personalization password.

PH-CORP The modem is waiting for corporate personalization un-blocking password.

PUK

GSM/HSPA Modems
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¢ Operator - the name of the operator in which network the modem is registered.
* Security Status - the Network Registration Status.
— Not registered, ME is not searching for a new operator
— Not registered, ME is searching for a new operator
— Registered, home network
— Registered, roaming
— Registration denied
* UnknownSignal Quality - indicates the quality of the received signal strength in dBm.
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Functions

¢ PIN Authentication — this function allows the modem to store the entered password. This may be for example
the SIM PIN1 to register to the GSM network, or the SIM PUK1 to replace a disabled SIM PIN1 with a new one,
or the PH-SIM PIN if the client has taken precautions for preventing damage in the event of loss or theft etc.
If no PIN1 request is pending (for example if PIN1 authentication has been done and the same PIN1 is entered
again) the modem responds "ERROR: operation not allowed"; no further action is required.
Each time a password is entered the module starts reading data from the SIM. The duration of reading varies
évith the S%M card. This may cause a delay of several seconds before all commands which need access to SIM

ata are effective.

— Input Parameters:
— PIN — Password (string type), usually SIM PIN1.
If the requested password was a PUK, such as SIM PUK1 or PH-FSIM PUK or another password, then
<PIN> must be followed by <new PIN>. If the requested code was a PUK: specify a new password or
restore the former disabled password.
— Output Parameters:
— Return Value — the result code (string type): OK or an error description.
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Successful PIN authentication only confirms that the entered PIN was recognized and correct. The
@@S output of the result code OK does not necessarily imply that the mobile is registered to the desired
- network. Typical example: PIN was entered and accepted with OK, but the modem fails to register to
the network. This may be due to missing network coverage, denied network access with currently
used SIM card, invalid roaming agreement between home network and currently available operators
etc.
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What to do if PIN authentication fails?

PIN1 / PUK1:

After three failures to enter PIN 1, the SIM card is blocked (except for emergency calls). ERROR: 12
prompts the client to unblock the SIM card by entering the associated PUK (= PIN Unblocking Key /
Personal Unblocking Key). After ten failed attempts to enter the PUK, the SIM card will be invalidated
and no longer operable. In such a case, the card must be replaced. PIN1 consists of 4 to 8 digits,
PUK1 is an 8-digit code only.

To unblock a disabled PIN1, enter <PUK1>,<new PIN1>.

b

N

* Facility Lock - this function can be used to enable or disable PIN verification by the SIM card.
— Input Parameters:
— Lock — Boolean variable which shows whether you want to enable or disable PIN verification.
— PIN — Password, usually SIM PIN1.
— Output Parameters:
— Return Value — the result code (string type): OK or an error description.
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CDMA Modems

This section describes the settings and features for the following GSM modems:

* Motorola C24 CDMA
e Wavecom Q26 Elite
e Wavecom Q2438 CDMA
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Topcon GNSS receivers with integrated CDMA cellular module are authorized to operate only on the
Verizon™ wireless network in the USAL.

1. Wavecom Q26 Elite is only used in Topcon GRS-1 GNSS receiver.

Settings

* Manufacturer — the manufacturer identification text.

* Model — the product model identification text.

¢ Hardware Version — the product hardware version.

e Firmware Version — the product firmware version.

* MEID/ESN - the Mobile Equipment Identifier or Electronic Serial Number of the product.
* Module Serial Number — the serial number of the module.

e IMSI — the International Mobile Subscriber Identity (IMSI) of the module.

* Signal Quality - indicates the quality of the signal strength in dBm.
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Functions

To use the CDMA modem, the user must activate it. For a start, contact the service provider, and set up a data plan.
You will need either the MEID or ESN, which is displayed on the Settings tab.

Then you must activate the module on the Verizon network. To do that, open the Functions tab, choose the
Activate (Verizon) function, and click the Execute button.
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<//\/>g If you are not able to activate the module on your own, contact the service provider.

SRL-35 Modem

This section describes the settings and functions for the SRL-35 modem.

@@ The SRL-35 modem does not have a cell module.

Settings
The Settings tab shows: general information about the modem type, software and hardware revisions, product code
and serial number, and displays a list of settings for the modem.

The SRL-35 radio modem offers a transmitter/receiver/repeater functionality with a maximum 35 W power output for
data transmission. The frequency range of the modem depends on the country in which the receiver is used.
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The settings can be read-only (marked by the icon) or changeable (marked by the icon). Clicking on the
corresponding line in the Value column of any editable parameter opens a field to enter or select from the drop-down
list a needed value.

* General parameters:
— Model — the product model identification text.
— Hardware Version — the hardware revision of the modem.
— Firmware Version — the firmware version of the modem.
— Product Code — specifies the product code.
— Serial Number — specifies the serial number unique for the modem.
— Baud Rate, baud — specifies the baud rate of the modem's serial port connected internally with the
receiver's serial port, by default with hardware flow control.
* Radio parameters:
— RX Frequency, MHz — the operating frequency used for data reception.
— TX Frequency, MHz — the operating frequency used for data transmission.
— Protocol — selects a protocol and a modulation type.
— Spacing, kHz — displays the channel spacing.
— Satel FEC — Forward Error Correction technique to maximize data communication. The rover radio modem
has the capability to check and correct transmission errors (if any) in an incoming data stream.
— Call Sign
— Power, W — sets the appropriate level of output power.
— Repeater — Enables/Disables repeater function.
— TX Delay, ms — Specifies TX delay.
— TX Addressing — Specifies TX address mode.
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— TX1 Address, hex — Specifies primary transmit address.

— TX2 Address, hex — Specifies secondary transmit address.

— RX Addressing — Specifies RX address mode.

— RX1 Address, hex — Specifies primary receive address.

— RX2 Address, hex — Specifies secondary receive address.

¢ FCS parameters:

— FCS Mode - Allows enabling Free Channel Scan mode.
In free channel scan mode, the Base radio modem will regularly scan the current operating frequency to
determine the degree of a radio noise (interference). Should the level of noise on the current operating
frequency be greater than the threshold specified in the Signal Threshold field, the transmitter will stop
broadcasting and switch to the next frequency.

— Net ID- sets Free Channel Scan Net ID.
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Occasionally, the receivers may encounter interference if a jobsite has more than one set of
//,ES receivers. In this case, enter a different net ID for each set of receivers.

¢ To properly communicate, the Base and Rover radios require the same settings for Current
Frequency, FCS and Net ID.

Functions
The UploadFile function is intended to upload the Modem Configuration File (MCF).

~ Be aware that the SRL-35 modem supports a wide UHF frequency range of 403-473 MHz with
= selectable channel spacing and has been provided to you in default factory configuration.
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Before operating the SRL-35 radio, you must upload the frequencies needed for radio communication in your specific
region. UHF frequencies in your region may be licensed or unlicensed but are always subject to some level of
restriction within the overall 403-473 MHz range. Your dealer should load the MCF before giving you the SRL-35 radio.
If your radio is not loaded with UHF frequencies specific to your region, contact your local dealer and request the MCF
containing licensed UHF frequencies, channel spacing, and output power.

Once you receive the MCF from the dealer (see “Appendix C” on page 133), you must have version 2.8 of TRU or later
to load the MCF file:
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Install TRU on your mobile device or computer.

Copy the MCF provided by your dealer, and paste it in the hard drive of your mobile device or computer.

Run TRU.

Connect to the receiver’s internal radio modem using TRU’s Modem Managing mode.

Click the Functions tab, and select UploadFile in the Function control.

In the File property of Input Parameters, select the MCF saved on a local drive and select MCF as the file type.
Click Execute to load the radio frequencies into the radio.

Click Execute again on Settings to ensure all frequencies are correctly loaded and appear available for use.

®NOU A WD =

A valid MCF configuration is mandatory before using the product. Failure to understand and apply

//,@ this procedure may result in non-operation of the SRL-35 radio or breach the local regulatory laws

- that govern radio communications. Refer to the SRL-35 Operator’s Manual for more details on the
SRL-35 radio. If you have questions or concerns, contact your local Topcon representative or dealer.
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Firmware Loader

Firmware Loader mode is used to load the firmware onto various devices within a Topcon GNSS receiver.

Device View Help

% T

Information Firmware Loader

5 Firmware Loader

Figure 16: Firmware Loader

GNSS receivers require firmware to properly operate and provide appropriate functionality. As TPS releases firmware updates,
loading these updates into the receiver ensures that the receiver operates at its full potential.
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Using TRU, you can load the firmware to all boards inside the receiver, including:

* GNSS board
* Modem board
¢ Bluetooth
* Power board
You can load the firmware to a GNSS board using a serial/USB/Blueooth/network connection.

Firmware for the modem, Bluetooth, and power boards can be loaded using a serial port connection only.
Loading Firmware Using Serial Port

Use of the serial port connection is the only way to update Power Board, Modem or Bluetooth firmware.

Be extremely attentive when selecting firmware updating parameters, especially when updating modem firmware.
Some modem models do not allow terminating of the firmware updating process. So if you choose incorrect parameter
combinations, or interrupt the firmware updating process, it may damage your equipment. If this happens, and you
cannot update firmware using the Power On capture, you must have the hardware serviced.

1. Click Device » Application Mode » Firmware Loader.
s TRU [N
Device | View Help

Connect

Disconnect
Setup
Application Mode » Simple Terminal

= Receiver Managing

] Madem Managing
| @ | Firmware Loader
= Firmware Loader &

Figure 17: Firmware Loader Mode
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2. Click Device » Connect, specify the corresponding connection parameters, and click Connect.

=
—— @Connection Par... [m=m|nl=ls .5

Disconnect
Setup

Application Mode 3

Exit

S Firmware Loader o

I
=
3
2
Q
=
(0]
-
(o]
Q
ol
()
=

Figure 18: Firmware Loader Connect - Connection Parameters

3. Click the Firmware Loader icon i
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4. For Device, select either Receiver/Modem/Bluetooth or Power Board.
— If you are updating firmware for a power board, you must select Power Board from the combo box.

— In other cases (if you are updating GNSS receiver, modem, or Bluetooth firmware), you must select the
Receiver/Modem/Bluetooth option.

5 Firmware Loader IE'@E

Device

Receiver Modem Bluetooth
Power Board l

Loader: EI
Image: EI

Capture Method
|Soft Break -

I
=
3
2
Q
=
(0]
-
(o]
Q
ol
()
=

|
! e |
o | Start

Figure 19: Firmware Loader - Device

Loading Firmware Using Serial Port P/N: 7010-0908 118




5. For Firmware, specify the full path to firmware files for the device by clicking the open folder icon Jor enter
the full path manually.
— If you are updating power board firmware, specify only the path to the Loader file (it usually has an .Idr
extension).
— In other cases, specify full paths to both Loader and Image files (the image file usually has an .ldp
extension).

r ~

S Firmware Loader = | B |-

Device

[Power Board 'I
Firmware

Loader: =
Image:

Capture Method
Soft Break v]

L

Figure 20: Firmware Loader - Firmware
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6. For Capture Method, select either the Soft Break, or the Power ON capture method.

— If you select the Soft Break method, the receiver switches into firmware updating mode through the
software.

— If you select the Power ON capture method, after you click the Start button, you will need to reset or
power cycle the receiver.

controller using the Power ON capture method, you do not need to reset the receiver. TRU does it

® Attention GRS-1 and Tesla users: When you are updating firmware of a TPS receiver integrated into a
automatically.

7. Click Next to select the firmware files.

8. Specify the full path to firmware files for the device by pressing the open folder icon J or enter the full path
manually.
— If you are updating power board firmware, you should specify only the path to the Loader file (it usually has
an .Idr extension).
— In other cases you should specify full paths to both Loader and Image files (the image file usually has an
.Idp extension).
9. Click Next to verify the device type, its hardware and current firmware versions before you start the firmware
loading.
10. Click Next to begin uploading firmware to the receiver. Pressing the Cancel button terminates the firmware
updating process. If the firmware updating process for a device has not been completed, the device may become
inoperative.

11. If the firmware has been uploaded, a successful message displays, and TRU disconnects from the receiver.
Otherwise, one of the error messages in Table 1 displays. To detect and fix the problem, use troubleshooting
procedures described in Table 1.
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Table 1. Firmware Troubleshooting

Error Message

Troubleshooting

Unknown error

Repeat firmware updating. If the error repeats, contact your dealer or manufacturer. It usually means
that there is a hardware problem, or your Flash file was corrupted.

The Loader file is not
compatible with the
hardware

The Loader (.Idr) file you selected is not compatible with your hardware. Select an appropriate .Idr file
and repeat firmware updating.

The Flash file is not
compatible with the
hardware

The Flash (.Idp) file you selected is not compatible with your hardware. Select the appropriate .Idp file
and repeat firmware updating.

The specified device
requires a newer version
of the loader

The version of TRU you are using cannot upload the firmware to your device. You need to get a more
recent Application version from your dealer.

The Loader file,
checksum is incorrect

Repeat firmware updating. If the error repeats, it means that the Loader file you have is corrupted,
and it must be replaced with a correct Loader file.

No response from the
device

This usually means that the device was disconnected from the controller. Make sure that a serial cable
is reliably attached to both the device, and the controller, and then repeat firmware updating.

Loading Firmware Using Serial Port
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Loading Firmware Using USB, Bluetooth, and Network Connections

Using USB, Bluetooth, and network connection, you can load the firmware to the GNSS receiver only.

* Device - this field cannot be changed, and it always displays Receiver.

* Firmware — specify the full path to a firmware file corresponding to the device by clicking the Open Folder
icon or enter the full path manually. You should specify full path to the Image file only (the Image file usually
has an .ldp extension).

* Start - click to begin uploading firmware to the receiver. After you click the button, it toggles to Cancel. Clicking
this button terminates the firmware updating process.

If the firmware has been uploaded, a successful message displays, and TRU disconnects from the receiver.

Image (.ldp) file to an internal memory card of the receiver. If the receiver does not have the internal

(D To update the firmware through a connection other than serial one, TRU first needs to copy the
memory card or there is not enough free memory on the card, firmware updating process will fail.
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Appendix A

The following table describes the channel spacing, protocol and modulation for each modem.

Table 2. Modem Channel Spacing, Protocol, and Modulation

RX Modem Channel Spacing Protocol Modulation

12.5 kHz PDL GMSK

TrimTalk GMSK

Digital UHF
25 kHz PDL GMSK

TrimTalk GMSK
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Table 2. Modem Channel Spacing, Protocol, and Modulation

12.5 kHz Satel 3AS 4-Level-FSK
PDL 4-Level-FSK

GMSK

TrimTalk* GMSK

Digital UHF Il

25 kHz Satel 3AS 4-Level-FSK
PDL 4-Level-FSK

GMSK

TrimTalk* GMSK
12.5 kHz Satel 3AS 4-Level-FSK
PDL 4-Level-FSK

GMSK

SATELLINE-3AS

25 kHz Satel 3AS 4-Level-FSK
PDL 4-Level-FSK

GMSK

P/N: 7010-0908
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Table 2. Modem Channel Spacing, Protocol, and Modulation

12.5 kHz Satel 3AS 4-Level-FSK _%>
PDL 4-Level-FSK '8
GMSK 3
Q.
25 kHz Satel 3AS 4-Level-FSK X
Topcon Q2 >
PDL 4-Level-FSK
GMSK
12.5 kHz Satel 3AS 4-Level-FSK
PDL 4-Level-FSK

*Use of PDL protocol is recommended in applications where possible. Note that a minimum baud rate of 9600 bps is
recommended for all RTK operations. Compatibility with TrimTalk is subject to some restrictions for radios listed above.

* TrimTalk protocol is supported on revision C of Satel-3AS boards(with FW3.39) integrated in Topcon GNSS receivers.
* Topcon Digital UHF is representative of systems that use Digital UHF I hardware with radio FW version 1.6 or previous.

Protocol, modulation, channel spacing and link rate should match between transmitting and receiving
radios for radio operations.
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Cell Module Details

Table 3 lists cellular specifications. %>

Table 3. Cellular Specifications -8

Quad Band GSM/GPRS/EDGE Module 3‘_-

Supported Bands GSM 850/900/1800/1900 MHz ;
TX Power 850/900 MHz — Class 4 (2 Watt)

1800/1900 MHz — Class 1 (1 Watt)

Data Features GPRS, Multi-slot Class 10, Max downlink 85.6
kbps, max uplink 42.8 Kbps

EDGE, Multi-slot Class 10, Max BR downlink
236.5 Kbps

CSD, Max BR 14.4 Kbps

AT Command Set GSM 07.05, 07.07 and 07.10

Regulatory and Approvals FCC, IC

ANATEL (Brazil)
COFETEL (Mexico)
CMII (China)

PTCRB

R&TTE/CE

GCF

QS9000 manufacturing
RoHS/WEEE/CCC
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Table 3. Cellular Specifications (Continued)

Dual Band CDMA 1xRTT Module

Supported Bands!

CDMA 800/1900 MHz

TX Power

800 MHz - Class 3 (24 dBm)
1900 MHz — Class 2 (24 dBm)

Data

1x/QNC/HSPD
CSD, Max BR 14.4 Kbps

AT Command Set

N/A

Regulatory and Approvals

CDG1, CDG2

FCC, IC, CCC

EMC

QS9000 manufacturing
RoHS/WEEE

1Topcon GNSS receivers equipped with integrated C24 wireless modules
are authorized to operate in the US only on the VerizonTM wireless

network.

3.5G Wireless Module (Quad-band GSM and UMTS/HSPA)

Supported Bands

GSM 850/900/1800/1900 MHz
UMTS/HSPA 850/1900/2100 MHz

P/N: 7010-0908
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Table 3. Cellular Specifications (Continued)

TX Power UMTS/HSPA - Class 3 (0.25 Watt)

GSM 850/900 MHz — Class 4 (2 Watt)

GSM 1800/1900 MHz — Class 1 (1 Watt)
EDGE 850/900 MHz — Class E2 (0.5 Watt)
EDGE 1800/1900 MHz — Class E2 (0.4 Watt)

Data Features UMTS/HSDPA/HSUPA 3GPP, Release 6
GSM/GPRS 3GPP, Release 9

Max uplink 5.76 Mbps, max downlink 7.2 Mbps
EDGE, Multi-Slot class 12

CSD, Max BR 14.4 Kbps GSM, Max BR 14.4
Kbps UMTS

Vv xipuaddy

AT Command Set GSM 07.05, 07.07

Regulatory and Approvals FCC, IC
ANATEL (Brazil)
PTCRB
R&TTE/CE

GCF
RoHS/WEEE
ACMA

BABT
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Appendix B

Digital UHF Radio Firmware v2.0 Upgrade Process
Supported Platforms

Digital UHF | Based Systems

* Original HiPer (I) series

* HiPer II/GRX1

* GR-3

* GR-5

e MC-R3 Controller/Receiver

Digital UHF Il Based Systems

HiPer 11

HiPer V

GR-3

GR-5

MC-R3 Controller/Receiver
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Identification of Radio Installed on the Receiver

Identify Digital UHF radio version number (i.e. Digital UHF I or II)
Connect receiver with the data collector or PC
Run TRU mobile or PC version
Connect with the internal modem of the receiver in modem managing mode of TRU
Click Settings » General Tab
— If the hardware listed in the Receiver Identification section is Aw-401Hi or Aw-401Tc, it is a Digital UHF I
radio based device.
— If the hardware information reports DUHFII, the receiver is installed with Digital UHF II modem.

FW 2.0 Activation on Digital UHF | Radio Modem

>
=
o
®
3
=
=
w

vk N =

1. The user determines whether loading FW 2.0, on Digital UHF I radio based products listed above, is free of
charge. A Digital UHF I Modem with serial number F30000000000 and higher for Digital UHF I modem does NOT
require unlock code i.e. Firmware 2.0 can be upgraded on the Digital UHF I radio installed on the receiver free of
cost.

2. Acquire the Modem serial number by connecting the modem to TRU Modem Managing mode (Settings »
General Tab).

<//\/>@ FW 2.0 is available for free for all Digital UHF II radios.
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2.0. FW 2.0 will not be operational on units which require security code for activation of firmware on
Digital UHF I based receivers. The user will have choice to revert back to v1.6 of the firmware on Digital
UHF I based receivers, if the security code for FW 2.0 is not available.

@ It is important to know whether your receiver is eligible for free upgrade before loading the firmware

>
=
o
®
3
=
=
w

3. If the modem serial number for Digital UHF I does not fall in the serial number cutoff mentioned in above step,
firmware 2.0 requires a security code to activate the firmware.

4. The user must record following information and send it to their local distribution:
¢ Serial number of the receiver
¢ Serial number of the modem board installed on the receiver

5. To order FW 2.0 upgrade and to get security code for this activation, the Dealer is required to submit a PO to
Topcon with following information:

* Upgrade part nhumber (listed below*)
¢ Serial number(s) of the receiver and Digital UHF I radio modem

Part Number Description Business Unit
1002754-01 Upgrade, FW v2.0, Digital UHF I Radio Survey
1002755-01 Upgrade, FW v2.0, Digital UHF I Radio Construction/MC
1002756-01 Upgrade, FW v2.0, Digital UHF I Radio AG
1002757-01 Upgrade, FW v2.0, Digital UHF I Radio MOEM

*Please select appropriate part number as per your associated business unit.
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@@S Contact your local Topcon dealer for more information about these part numbers.
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6. Request for security code will be processed by options@topcon.com.

7. Once you receive security code for Digital UHF I modem installed on your receiver, upload Firmware 2.0 using
Firmware Loader application mode in TRU 2.8 or later.

8. Once firmware is loaded on the modem, connect receiver in Modem Managing Mode in TRU. TRU will ask user to
enter valid security code. Entering invalid or no security code will result into non-activation of the firmware 2.0 for
Digital UHF I radio; as mentioned above, user will have an option to revert back to previously released FW 1.6.
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Appendix C

Creating a Configuration File (MCF/CCF/CCX)

To create necessary regional or licensed frequencies through a Configuration File (DCF/MCF or CCX) you need a
dealer/advanced license of TRU. The dealer/advanced license is only available to your Topcon representative or dealer.

Contact your Topcon representative or dealer to obtain a configuration file for your external radio or receiver with integrated
radio. You will need to inform the dealer the specific frequencies on which you plan to operate your radio. Remember to make
sure that these frequencies are compliant with your regional radio regulations. Once you provide the operational frequencies,
the dealer can provide the configuration file to work with your radio. With TRU 2.8 or later, the dealer does not need to access
your external radio or receiver to create a configuration file for you.

® DCF/MCF or CCX creation is only available in Dealer/Advanced license of TRU.

Appendix C P/N: 7010-0908 133



R
. T400 Natic d
SRS ) :

o,

~ Topcon Positioning Sys

ll.:ll 'l.l

http://www.topcontotalcare.com

TRU Reference Manual
P/N 7010-0908 Rev G

©2014 Topcon Positioning Systems, Inc.
All rights reserved. No unauthorized duplication.




	TRU Reference Manual
	Inside Cover: TRU Reference Manual
	Table of Contents
	Preface
	Terms and Conditions
	Use
	Copyrights
	Trademarks
	Disclaimer of Warranty
	License Agreement
	Confidentiality
	Website; Other Statements
	Safety
	Miscellaneous
	Manual Conventions


	Introduction
	Installing TRU
	Main Window
	Device
	Application Modes
	Setup
	General
	Status
	Modems


	Help
	Register
	Help
	About

	Exiting TRU

	Connection
	Connecting to the Device
	Serial Port Connection
	Bluetooth Connection
	USB Connection
	Network Connection

	Disconnection Auto Detection

	Simple Terminal
	Terminal Parameters

	Receiver Managing
	Terminal
	Information
	Options
	Upload OAF

	Tools
	Receiver Settings
	Tracking
	Signals
	Antenna
	Observations
	Advanced
	Raw Measurements and Position Update Rates
	GPS
	GLONASS
	Galileo
	BeiDou
	SBAS
	QZSS
	OmniSTAR

	Positioning
	General Parameters
	RTK Parameters
	Advanced RTK Parameters
	Base Station Parameters

	HD2 Parameters
	VISOR Parameters
	Advanced VISOR Parameters
	Ports
	Receiver Ports
	Serial Ports
	Network Settings
	FTP Settings
	TCP Settings



	Messages
	Receiver Message List
	Receiver Message

	Bluetooth (HiPer SR only)
	Power
	Power (HiPer SR Cellular Model Only)
	Auto Seed
	Point List
	Add New Point

	Volume Control
	Master Volume

	Bluetooth
	Bluetooth (HiPer II and HiPer V only)
	Bluetooth (HiPer SR only)
	Dual SIM Management

	Status
	Position
	Heading
	Data Link
	SVs List
	Sky Plot
	Scatter Plot
	Position in Time
	Logging
	Logging Messages
	Site Configuration


	File Explorer
	Files
	Information about File System
	Files (HiPer II and HiPer V only)

	Logs
	Logs (HiPer II and HiPer V only)

	MINTER
	Advanced Settings
	MINTER (HiPer II and HiPer V only)

	AFRM
	UMS Files
	UMS Device Information


	Modem Driver
	Modem Properties: Modem
	Modem Properties: Driver
	Updating Modem Driver: Selecting Driver Source
	Updating Modem Driver: Selecting Driver
	Updating Modem Driver: Variables
	Updating Modem Driver: Installing Driver

	GRS Tools
	Receiver
	Modem
	Compass

	Backpack Tools

	Modem Managing
	General Information
	Modem Settings
	Modem Functions

	Modem Types
	FH915 Plus
	Settings

	Topcon UHF460
	Settings

	Digital UHF
	Settings
	Functions

	Digital UHF II
	Settings
	Functions

	Satel® UHF Modem
	Settings
	Functions

	Q2
	Settings
	Functions

	GSM/HSPA Modems
	Settings
	Functions

	CDMA Modems
	Settings
	Functions

	SRL-35 Modem
	Settings
	Functions


	Firmware Loader
	Loading Firmware Using Serial Port
	Loading Firmware Using USB, Bluetooth, and Network Connections

	Appendix A
	Appendix B
	Digital UHF Radio Firmware v2.0 Upgrade Process
	Supported Platforms
	Digital UHF I Based Systems
	Digital UHF II Based Systems

	Identification of Radio Installed on the Receiver
	FW 2.0 Activation on Digital UHF I Radio Modem


	Appendix C
	Creating a Configuration File (MCF/CCF/CCX)

	Back Cover

